Contact:  Modelleisenbahn GmbH  
Plainbachstraße 4  
A-5101 Bergheim  
e-mail: rocomotion@roco.cc  
http://www.roco.cc

Product Supplier, Distribution and Customer Service:  
Modelleisenbahn GmbH, Bergheim

Ownership and Copyright of the Software,  
Program Development and Documentation:  
Freiwald Software, Egmating, Germany  
http://www.freiwald.com  
Copyright© Freiwald Software 1995 – 2009. All rights reserved.

The content of this manual is furnished for informational use only, it is subject to change without notice. The author assumes no responsibility or liability for any errors or inaccuracies that may appear in this book. No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, without the prior written permission of the author.
Table of Contents

About this Document ...................................................................................................................... 6
   Rocomotion Users Guide ........................................................................................................ 6
   Help Menu ................................................................................................................................ 6

1 Quick Start Tutorial .................................................................................................................. 8
  1.1 Quick Start - Step 1: Installation and Program Start ......................................................... 8
       Installation .............................................................................................................................. 8
       Program Start ........................................................................................................................ 9
  1.2 Quick Start - Step 2: Controlling a Train ............................................................................. 11
       Preparing a Train for Model Railroad Computer Control ................................................. 11
       Controlling a Train ............................................................................................................... 14
  1.3 Quick Start - Step 3: Controlling Switches – The Switchboard ........................................... 15
       Creating a small switchboard control panel ....................................................................... 15
       Preparing a Switch for Model Railroad Computer Control .............................................. 18
  1.4 Quick Start - Step 4: Creating Blocks - Tracking Train Positions ....................................... 19
       Equipping the layout with feedback sensors ...................................................................... 19
       Dividing the layout into Blocks .......................................................................................... 20
       Entering the locations of Blocks into the Switchboard ...................................................... 21
       Assigning Feedback Sensors to Blocks ............................................................................... 22
       Displaying train positions on the Computer Screen ......................................................... 24
  1.5 Quick Start - Step 5: Controlling Trains Automatically ....................................................... 26
       AutoTrain™ .......................................................................................................................... 26
       Creating a Commuter Train ................................................................................................. 27

2 Introduction ............................................................................................................................... 32
  2.1 Overview ............................................................................................................................... 32
       Use ........................................................................................................................................ 32
       Automatic Operation ............................................................................................................ 34
  2.2 Fundamentals of Use ............................................................................................................. 34
       The Overall Principle ........................................................................................................... 34
       File Handling ..................................................................................................................... 35
       Window Handling ............................................................................................................... 35
       Edit Mode ............................................................................................................................ 36
       Further Steps ....................................................................................................................... 36
       The Switchboard ................................................................................................................ 37
       Train Windows .................................................................................................................... 38
       The Visual Dispatcher ....................................................................................................... 38

3 The Switchboard ....................................................................................................................... 40
  3.1 Introduction ............................................................................................................................ 40
  3.2 Drawing the Track Diagram ............................................................................................... 41
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.3</td>
<td>Connecting the Switches</td>
<td>42</td>
</tr>
<tr>
<td>3.4</td>
<td>Signals and Accessories</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>Signals</td>
<td>45</td>
</tr>
<tr>
<td></td>
<td>Accessories</td>
<td>46</td>
</tr>
<tr>
<td></td>
<td>Connecting Signals and Accessories</td>
<td>46</td>
</tr>
<tr>
<td>3.5</td>
<td>Routes</td>
<td>46</td>
</tr>
<tr>
<td></td>
<td>Manual Routes vs. Automatic Routes</td>
<td>46</td>
</tr>
<tr>
<td></td>
<td>Recording of manual Routes</td>
<td>47</td>
</tr>
<tr>
<td>3.6</td>
<td>Text Labels</td>
<td>48</td>
</tr>
<tr>
<td>3.7</td>
<td>Images</td>
<td>48</td>
</tr>
<tr>
<td>3.8</td>
<td>Displaying Train Names and Symbols in the Switchboard</td>
<td>49</td>
</tr>
<tr>
<td>4</td>
<td>Train Control</td>
<td>50</td>
</tr>
<tr>
<td>4.1</td>
<td>Introduction</td>
<td>50</td>
</tr>
<tr>
<td>4.2</td>
<td>Engines and Trains</td>
<td>52</td>
</tr>
<tr>
<td>4.3</td>
<td>The Throttle</td>
<td>53</td>
</tr>
<tr>
<td>4.4</td>
<td>Speedometer and Odometer</td>
<td>54</td>
</tr>
<tr>
<td>4.5</td>
<td>Automatic Speed and Brake</td>
<td>55</td>
</tr>
<tr>
<td></td>
<td>The Speed Profile</td>
<td>55</td>
</tr>
<tr>
<td>4.6</td>
<td>Headlights, Steam and Whistle</td>
<td>56</td>
</tr>
<tr>
<td>4.7</td>
<td>Acceleration and Train Tonnage</td>
<td>57</td>
</tr>
<tr>
<td>4.8</td>
<td>Passing control between Computer and Digital System</td>
<td>58</td>
</tr>
<tr>
<td>5</td>
<td>Contact Indicators</td>
<td>59</td>
</tr>
<tr>
<td></td>
<td>Momentary Track Contacts vs. Occupancy Sensors</td>
<td>59</td>
</tr>
<tr>
<td>6</td>
<td>The Visual Dispatcher I</td>
<td>63</td>
</tr>
<tr>
<td>6.1</td>
<td>Introduction</td>
<td>63</td>
</tr>
<tr>
<td>6.2</td>
<td>Blocks</td>
<td>67</td>
</tr>
<tr>
<td></td>
<td>Blocks on the Layout</td>
<td>67</td>
</tr>
<tr>
<td></td>
<td>The Main Block Diagram</td>
<td>69</td>
</tr>
<tr>
<td></td>
<td>Links and Routes between Blocks</td>
<td>72</td>
</tr>
<tr>
<td>6.3</td>
<td>Direction of Travel vs. Engine Orientation</td>
<td>73</td>
</tr>
<tr>
<td></td>
<td>Direction of Travel</td>
<td>73</td>
</tr>
<tr>
<td></td>
<td>Engine Orientation</td>
<td>74</td>
</tr>
<tr>
<td>6.4</td>
<td>States of a Block</td>
<td>74</td>
</tr>
<tr>
<td></td>
<td>Occupied Block</td>
<td>74</td>
</tr>
<tr>
<td></td>
<td>Reserved Block</td>
<td>75</td>
</tr>
<tr>
<td></td>
<td>Current Block</td>
<td>75</td>
</tr>
<tr>
<td></td>
<td>Display of Train Positions</td>
<td>77</td>
</tr>
<tr>
<td></td>
<td>Locking of Blocks</td>
<td>77</td>
</tr>
<tr>
<td></td>
<td>Locking the exit of Blocks</td>
<td>77</td>
</tr>
<tr>
<td>6.5</td>
<td>Train Tracking</td>
<td>77</td>
</tr>
<tr>
<td>6.6</td>
<td>Blocks and Indicators</td>
<td>79</td>
</tr>
</tbody>
</table>
6.7 Stop and Brake Indicators ................................................................. 80
6.8 Arranging Indicators in a Block ........................................................ 84
    Arranging Momentary Track Contacts and Occupancy Sensors in a Block 84
    One Sensor per Block: Combined Brake/Stop Indicators .................... 87
6.9 Block Signals ....................................................................................... 88
    General ................................................................................................... 88
    Signal Aspects ..................................................................................... 89
    Colour ................................................................................................. 89
    How to use Signals on the Model Railroad Layout .............................. 90
    Additional Notes .................................................................................. 91
6.10 Schedules .......................................................................................... 92
    Schedule Diagrams ............................................................................. 92
    Start and Destination of a Schedule ..................................................... 93
    Alternative Paths ................................................................................ 95
6.11 Execution of Schedules ................................................................. 98
    Starting a Schedule ............................................................................ 98
    Reservation of Blocks and Routes ....................................................... 99
    Path Selection ...................................................................................... 100
    Release of Blocks and Routes ............................................................ 101
    Simulation of Train Movements without Connection to a Model Railroad 102
    Restricted Speed and Wait Time ......................................................... 102
    Type of a Schedule - Shuttle and Cycle Trains .................................. 103
    Running Trains manually under Control of a Schedule ...................... 103
6.12 AutoTrain – Start of Schedules made Easy ...................................... 104
6.13 Successors of a Schedule ............................................................... 106
6.14 Schedule Selections ........................................................................ 108
7 The Traffic Control .............................................................................. 109
8 A Sample Layout ................................................................................ 110
    General ................................................................................................ 110
    Step 1: Creating the Switchboard ....................................................... 111
    Step 2: Defining the Engines ............................................................ 112
    Step 3: Creating Blocks .................................................................... 114
    Step 4: Contact Indicators ............................................................... 116
    Step 5: Creating Schedules ............................................................... 119
    Manual Operation ............................................................................... 120
Appendix ................................................................................................. 121
    Using digital Components of the ROCO System ............................. 121
        Programming the Switch Decoder 10775 using Rocomotion .............. 121
        Programming the Feedback Module Decoder 10787 using Rocomotion 121
Index ....................................................................................................... 122
About this Document

Rocomotion Users Guide

An overview of the basic concepts of Rocomotion is provided in this Users Guide. By reading this document one can obtain information about the many features of the product. Additionally you are provided with background information necessary for model railroad computer control with Rocomotion.

The document begins with a quick start tutorial for users, who are in a hurry and are in a fever to start quickly. The rest of this document explains the fundamentals of use. Knowing the contents of this part you will be able to control your switches, signals, routes and trains manually and to perform basic automatic operation.

Details of usage are mentioned only if they are necessary to understand the related issues, or to point to important features of the program.

Several sections or paragraphs show additional markings for novice or advanced readers or to indicate important notes. The markings and their meaning are:

B Basic content. Novice readers should focus on these parts.

X Extended content for advanced users. Novice readers should ignore these parts in the beginning.

! Important note.

Help Menu

The help menu installed with Rocomotion contains detailed reference information necessary for using the program. All menus, dialogs and options are completely described and can be referred to in case of questions or problems.

Please note: no document is complete without the other. If you want to know, what a certain term means or what a certain function does, refer to the Users Guide, please. If
you want to know, how a certain object is to be edited or how a specific function is to be executed, call the help menu.
1 Quick Start Tutorial

1.1 Quick Start - Step 1: Installation and Program Start

You have obtained Rocomotion to control your model railroad with your computer. It is easily understood, if you are eager to control your layout with your computer as soon as possible. If you are in a hurry about starting without reading the complete Users Guide first, you can also reconstruct the following quick start tutorial about Rocomotion.

Detailed explanations about the concepts, that are the fundamentals of the following, can be found in the remainder of this document. It is strongly recommended to study these contents prior to working seriously with Rocomotion.

Now let us start:

**Installation**

The installation file of Rocomotion, its name is RMSETUP.EXE, can be started from the CD ROM delivered with the hardware interface or be downloaded from the service area of the Internet home page of the software (www.roco.cc).

After starting RMSETUP.EXE a self-explaining window is displayed, that guides you through the steps, that are necessary to install Rocomotion on your computer.
Ensure, that you select the right language, because the selected language will also appear later, when running **Rocomotion**.

Before you start **Rocomotion** you should connect your digital system, with which you are controlling your model railroad, to the computer. Please refer to the instructions provided for your digital system, how this is done.

**Program Start**

After correct installation of **Rocomotion** there should be an entry in the **Start** menu of your Windows system, with which you can start the software.
After start of the program the connected digital system is to be configured. Usually the following screen appears automatically, when the program was started the first time. If the program starts without displaying the screen shown below, then call the **Setup Digital Systems** command of the **Railroad** menu.

![Setup Digital Systems dialog](Diagram 2: Setup Digital Systems dialog)

Here select the USB port or serial port of your computer, to which your digital system is connected.

In order to test, whether the connection to the digital system is properly established, play around a little bit with the **Power Off** and **Power On** command of the **Railroad** menu. These commands stop or start your digital system, respectively. Your digital system should respond accordingly to these commands. If your digital system does not respond or if there are even some error messages, then do not proceed any further, until this problem is resolved. In case of problems in this area, check very thoroughly, that the digital system is properly connected to the computer according to the instructions of the manufacturer.
If the steps outlined above have been performed correctly, you are ready to do the first steps into model railroad computer control.

1.2 Quick Start - Step 2: Controlling a Train

Preparing a Train for Model Railroad Computer Control

First put a train onto the tracks of your layout and run it with your digital system. This step is recommended to verify, that the digital system and the train are correctly running and also, to bring the digital address of the train back to your mind. This is needed a few moments later.

Now ensure, that the Edit Mode option in the View menu is active.

In this mode it is possible to enter new data into the software or to change existing data. This is what we want to do next.

Call the New Train Window command of the Window menu. If this is done correctly, the following window will appear on your computer screen:
If you want to learn more about the various controls of this window, refer to chapter 4, “Train Control”, please.

Now select the **Properties** of the **Edit** menu. This is one of the most important commands of **Rocomotion**. It is used for all objects contained in the software (trains, turnouts, signals, routes, etc.), whenever it is required to change the settings of a particular object. The following window is displayed now:

Specify the same address, that you have been using previously to control the train with your digital system, in the field labelled **Address**. If you want to give your engine a
name, that can be more easily remembered, select the tab labelled **General** and enter an appropriate name. In the following we want to call this train “Passenger Train”.

You can see this name entered into the program in the image displayed below:

![Diagram 6: Entering a Name](image)

Now press **OK** to close the dialog and to commit these changes. We are returning now to the main screen and are ready to control the train:
Controlling a Train

Diagram 7: Train Window

You may notice, that the colour of some controls in the train window changed. This happened due to the fact, that we entered a digital address for our train. Now the software knows, how to control the train. To prove this move the mouse to the green control in the centre of the window. Click to it and drag the green control to the right. If everything has been done correctly so far, the train will slowly start to move. We have done the first successful step into model railroad computer control!

Before continuing I suggest to enjoy playing with the train. Play around with the green control, which is actually an on-screen throttle, drag it to the right and back to zero, then to the left and watch, how your train responds to these actions. See, how the speedometer needle top of the throttle indicates the scale speed of your running train. Watch the odometer increasing. By clicking the green arrow at the bottom of the screen you will reverse the direction of your train.

There are much more things, that Rocomotion can do for realistic control of your trains. You can operate auxiliary functions (light, whistle, coupler, etc.), adjust the momentum to your personal needs and scale the speed and distance measurements to the physical characteristics of your train. This is discussed in detail in chapter 4, “Train Control”.

14
1.3 Quick Start - Step 3: Controlling Switches – The Switchboard

Creating a small switchboard control panel

So far the area in the background of the main window of Rocomotion is still empty. It contains a number of cells, that are arranged in rows and columns. These cells are still empty. We want to fill this empty area with a small switchboard control panel for the following small track layout:

![Diagram 8: Small Sample Layout](image)

In the first step we draw the track diagram in the switchboard window. First ensure please, that Edit Mode in the View menu is still turned on (see Diagram 3). Next select the Draw tool in the Tools menu.
Now move the mouse to a cell in the switchboard window, where the left end of our track diagram shall be located. Click and hold the left mouse button and drag the mouse about 25 cells to the right. Then release the left mouse button. The following image should be visible now in the switchboard window:
We have drawn a straight track section. Now move the mouse to a cell on this track section, that is located about one third right of the left end. Click the left mouse button and drag the mouse one cell to the right and one cell up. Then release the left mouse button. Now you should see something similar to the following:

The first switch (or turnout, respectively) in the switchboard is created now. Now click to the cell, where the diverging route of this switch ends and drag the mouse to the right to a cell, that is located about one third left of the right end of the straight track section.

Finally click to the cell, where the last mouse movement ended, and drag the mouse one cell to the right and one cell down.

The track diagram of our small sample layout is now completed and should look similar to Diagram 13.

If you want to operate real switches of your existing model railroad with the track diagram control panel just created, try to identify a small area of your layout, that contains a similar track structure with two switches as shown above. Now operate these switches with your digital system. This step is recommended to verify, that the digital system and
the switches are correctly working and also, to bring the digital addresses of the switches back to your mind. This is needed in the next step.

**Preparing a Switch for Model Railroad Computer Control**

Ensure, that the **Edit Mode** option in the **View** menu is still active (see Diagram 3).

Now click to the symbol of the left switch in the track diagram and select the **Properties** of the **Edit** menu. Do you remember? This command is used for all objects contained in the software (trains, turnouts, signals, routes, etc.), whenever it is required to change the settings of the particular object. The following window is displayed now:

![Diagram 14: Specifying the Digital Address](image)

Specify the same address, that you have been using previously to control the corresponding real switch with your digital system, in the field labelled **Address**. Now click to the symbol of the switch, that is located right of the label **Test**. The real switch on your model railroad layout should respond now. Depending on the wiring of your switch it may happen, that the image in the software and the physical switch do not show the same status (closed vs. thrown). If this is the case click to the grey circle in the
upper row of the **Output Configuration** to adjust the displayed status (see Diagram 14). The highlighting in the **Output Configuration** should change now and the displayed image of the switch and the status of the switch should be in sync, when you test the switch again.

If you want to give your switch a name, that can be more easily remembered, select the tab labelled **General** and enter an appropriate name.

Now press **OK** to close the dialog and to commit these changes. We are returning now to the main screen and are ready to control the switch. To do this, turn off **Edit Mode** in the **View** menu (see Diagram 3), move the mouse to the symbol of the switch in the track diagram of the switchboard window, click to this symbol and watch, how the real switch on your layout responds.

Finally perform the same for the right switch symbol in the track diagram.

We are now able to control a train and a small layout manually with the computer. I suggest to run the train back and forth on this small layout a little bit and to play with different routes by changing the positions of each switch prior to each run of the train.

In the next step we want to learn, how trains can be operated automatically under control of the computer.

### 1.4 Quick Start - Step 4: Creating Blocks - Tracking Train Positions

**Equipping the layout with feedback sensors**

The most important prerequisite to control trains automatically with your computer or to monitor the movements of trains on the computer screen is equipping the layout with feedback sensors. These sensors are used to report train movements back to the computer. Based on this information **Rocomotion** is able to take the right decisions to direct automatically running trains to their destination or to monitor the movement of trains.

Feedback sensors differ in occupancy sensors and momentary track contacts. Details of this difference and more detailed information about feedback sensors can be found in chapter 5, “Contact Indicators”.

In the following we assume, that momentary track contacts are used to control our small layout and that our layout is divided into four blocks with two contacts each according to the following images:

![Diagram 15: Detection Sections and Occupancy Sensors](image)

There are other possibilities to divide a layout into detection sections or to control it with momentary track contacts. The scheme displayed above is also not necessarily the optimal solution, too. The above scheme has been chosen for this tutorial for reasons of simplicity and because it is sufficient to perform a quick start. Other variants to equip your layout with feedback sensors are outlined in more detail in section 6.8.

**Dividing the layout into Blocks**

Another important prerequisite to control trains automatically with your computer or to monitor the movements of running trains is separating the layout into logical blocks. Blocks are the base elements for automatic train control and tracking of train positions. There is a close relation between feedback sensors and blocks: each block is associated with one or more feedback sensors.

We divide our small sample layout into blocks as shown below:

![Diagram 16: Dividing a layout into Blocks](image)

As you can see we have applied a 1:2 relation between blocks and detection sections here, i.e. each block is equipped with two momentary track contacts, with which each train can be stopped on both ends of each blocks. Please keep in mind, that blocks and feedback sensors are not the same thing.
More details about this topic are outlined in detail in section 6.6, “Blocks and Indicators”.

**Entering the locations of Blocks into the Switchboard**

Blocks are represented by **Rocomotion** on the computer screen by rectangular symbols. These symbols are also called **traffic boxes**, because they usually show more than just a block. To enter the blocks or traffic boxes, respectively, that are needed to control our train on our sample layout, turn on **Edit Mode** in the **View** menu and select the **Traffic Box** command of the **Tools** menu.
Now click to the cell, that is located right of the cell, that contains the left end of our track diagram. A traffic box, that represents the first block, will appear at this location.

![Diagram 18: Traffic Box in the Switchboard](image)

Please do the same for the three other blocks. Note, that the cell, where you click, determines the leftmost end of the traffic box. Ensure also, that you click into a cell, that contains a piece of straight track.

You can change the size of each traffic box by dragging its left or right border.

If everything was done correctly, the track diagram should look like the following image:

![Diagram 19: The complete Track Diagram with all Traffic Boxes](image)

**Assigning Feedback Sensors to Blocks**

There is a close relation between feedback sensors and blocks: each block is associated with one or more feedback sensors. Feedback sensors are represented in Rocomotion by contact indicators. To associate a feedback sensor with a particular block, select “Block 1” in the switchboard track diagram and call the Properties command of the Edit menu. The following dialog box is displayed now:
Diagram 20: Assigning a Contact Indicator to a Block

It shows the properties of the block and indicates, that two contact indicators are already assigned to this block by default. Double click the top entry in the list box labelled **Assigned Indicators** or press **Properties**. The following dialog box appears:

Diagram 21: Specifying the Digital Address of a Contact Indicator
Now specify the digital address of the feedback sensor, that belongs to this contact indicator. This is the digital address of the feedback decoder and the number of the contact input of this decoder, to which the sensor is connected.

To test your settings, put a train or anything else, that is suited to trigger a feedback event, on the track section, that corresponds to “Block 1” and cause the train to trigger the track contact. The traffic box in the track diagram in the switchboard should now change its colour to red:

![Diagram 22: Indication of an occupied Block](image)

Now assign contact indicators to the other three blocks, too.

If this has been done correctly, the traffic boxes in the switchboard will change their colour according to the movements of your train on the layout. Play around a little bit with your train and watch how the blocks in the switchboard are indicated.

**Displaying train positions on the Computer Screen**

Now we are ready for *train tracking*, i.e. displaying of train positions on the computer screen.

To do this move your real train into “Block 1”, if it is not located there already. Ensure, that the train is heading towards the other blocks, i.e. that it has to run forward, in order to go to “Block 2” or “Block 3”, respectively.

Then turn off **Edit Mode** in the **View** menu (see Diagram 3). Next select “Block 1” in the switchboard and call the **Assign Train** command of the **Block** menu according the following image:
In the following dialog select the “Passenger Train” and mark the option near the arrow pointing to the right.

After pressing OK the symbol and the name of the train will appear in “Block 1” in the switchboard control panel:
Instead of using the **Assign Train** command you can also drag and drop the train symbol with the mouse from another place on the computer screen to “Block 1”, if the train symbol is visible somewhere else.

Now run the train with the on-screen throttle of the train window displayed in Diagram 7. When the train travels to another block, then the display should be updated accordingly and the name and symbol of the train should move to the symbol of the other block, too. If you are testing this on a bigger layout ensure please, that the train does not leave the area, that is controlled by blocks and feedback sensors as described so far.

If all steps are performed correctly so far, then you are able to control the movement of your train and operate your switches with **Rocomotion**. You are also able to track the positions of moving trains on the computer screen.

### 1.5 Quick Start - Step 5: Controlling Trains Automatically

**AutoTrain™**

The last part of our quick start tutorial is automatic control of running trains. In the first step a train located in “Block 1” of our small sample layout shall run to “Block 4” and stop there. To do this run our train manually back to “Block 1”. Train tracking should ensure, that the display reflects this movement and finally looks like Diagram 25. Ensure also, please, that **Edit Mode** in the **View** menu is turned off (see Diagram 3).

Now press the key ‘A’ on your computer keyboard and move the mouse pointer to the train symbol located in “Block 1” while pressing ‘A’. The mouse cursor should now show an ‘A’ and an arrow pointing to the right:

![A→](image)

Click to the train symbol and drag the mouse to “Block 4”, to be precise into the right half of “Block 4” until the mouse pointer shows again the same sign as displayed above. Now release the left mouse button and the key ‘A’. The display in the switchboard should now change and show something similar like the following:
Simultaneously the real train on your layout should start to move now and run through “Block 2” or “Block 3” to “Block 4”, where it should slow down and stop.

After the train stopped, you can let it run back to “Block 1” automatically by dragging the train symbol back to “Block 1” while pressing the ‘A’ key as outlined above. Please ensure, that the mouse pointer now points to the left before clicking to the train symbol and before releasing the left mouse button, since the train should now run to the opposite direction.

If the train does not stop at the desired location in “Block 1” or “Block 4”, then you can adjust the ramp, which is applied to the deceleration and stop of the train, by using the Ramp option (see Diagram 20). More information can be also found in section 6.7, “Stop and Brake Indicators”.

**Creating a Commuter Train**

As a final step of our tutorial we want to run the train automatically back and forth between “Block 1” and “Block 4” several times. The train shall always select the right block with regard to direction of travel, i.e. when running to the right, the train shall pass “Block 3”, when running to the left the train shall pass “Block 2”. Additionally the train shall perform a short intermediate stop in “Block 2” and “Block 3”, respectively, during each pass.

To do this run the train manually back to “Block 1”. Train tracking should ensure, that the display reflects this movement and finally looks like Diagram 25. Ensure also, please, that **Edit Mode** in the **View** menu is turned off (see Diagram 3).
Now select “Block 2” and call the Lock Exit to the Right/Bottom command of the Block menu. This ensures, that the train will not pass through “Block 2” on its way to “Block 4”. Then select “Block 3” and call the Lock Exit to the Left/Top command of the Block menu.

Next select “Block 1” and call the AutoTrain command of the Schedule menu. This opens the AutoTrain™ tool bar as displayed below:
Ensure, please, that a green marking appears at the right side of “Block 1”. This indicates, that we want to start our train in this block with direction to the right. If this marking is not set, select “Block 1” and press 

Next select “Block 4” and press 

This indicates, that the train shall enter “Block 4” from the left to the right and stop here. Now press 

The software now checks, whether there is a path from “Block 1” to “Block 4”. As a result “Block 2” and “Block 3” are displayed on the screen with the same intensity as “Block 1” and “Block 4”. This indicates, that there is a path from “Block 1” to “Block 4”, that passes “Block 2” or “Block 3”, respectively.

Now press 

Rocomotion opens the following dialog:
Here select Shuttle as Type and 10 as Repeat Count. This tells the software, that you want to create a train, that is running back and forth (shuttle) ten times. You can certainly specify any other number as Repeat Count as well. Commit your settings with OK.

Now select “Block 2” and press . Rocomotion opens the following dialog:
Enter 02:00 in the box below Wait and Signal. This tells the software, that the train shall wait 2 simulated minutes in “Block 2”. The duration of simulated minutes is scaled with the speed of the internal fast clock. Commit your settings with OK. Perform the same steps for “Block 3” to specify a wait time for “Block 3, too.

Now press 🚂. The train now starts to move towards „Block 3“. In “Block 3” it slows down and stops for a few moments. Then it starts again and enters “Block 4”. Here it slows down again, stops and starts to the opposite direction. In “Block 2” it slows down and stops again. After a few moments it starts again and runs to “Block 1”, where it stops. Then the complete cycle is repeated again.

You are now able to configure control of automatically running trains. However, Rocomotion is certainly able to perform much more complex train control on much more complex track layouts. Rocomotion cannot only control perpetually running commuter trains or trains, that run perpetually around a loop. Rocomotion can perform intermediate train stops. Rocomotion can operate hidden yards automatically. And much more. Proceed with the remainder of this Users Guide, please, to learn, how these amazing things can be done with Rocomotion.
2 Introduction

2.1 Overview

**Rocomotion** is a system to operate a model railroad layout with the ROCO-Digital system from a Personal Computer running MS Windows 7, Windows Vista, Windows XP, Windows 98, Windows ME, Windows 2000 or Windows NT.

**Rocomotion** provides you with the ease of point and click to operate your switches, signals, routes and other accessories displayed on track diagram panels. You can run your trains with on-screen throttles, or with hand held throttles supported by your digital system. Far-reaching automation features make railroad operations manageable by one person and match those found on the largest club layouts. You can see on the screen which engine/train is on which track.

**Rocomotion** also supports an offline mode that allows trial operation without a connection to a real model railroad. Up to nine digital and control systems can be connected simultaneously.

**Rocomotion** is based on **RAILROAD & CO. TrainController™**, the proven software for model railroad computer control. It has been tailored to the ROCO digital system and ease of use. Later upgrade to the extended and individual features of **TrainController™** is possible at any time without the need, to enter your layout data again.

**Use**

**Rocomotion** is easy to use. It provides an easily learned, intuitive, graphical user interface that is developed according to the following guidelines:

- Use of **Rocomotion** is possible without the need to be a computer expert or programmer.
- Graphical items are provided instead of an abstract command syntax.
- Operation is based on natural objects like trains, switches, signals, etc. instead of digital addresses or something else.
- Activities are natural - point to a signal and set it to red with a simple mouse click instead of issuing a command like “set contact output of decoder 35 to 1”. Accele-
rate a train to speed 35 mph instead of typing “set speed level of train decoder 16 to 7”.

- Automatic Operation can be arranged within minutes without the need to learn a programming language first.
Automatic Operation

Because you want to control your model railroad with your computer, you are probably interested in operating parts (or all) of your layout automatically. **Rocomotion** does not require you to be an experienced programmer or computer expert in order to do this. For this reason, **Rocomotion** does not require to learn a special railroad programming language with a new syntax. Automatic operation can be accomplished by a simple point and click to the objects which are to be operated or monitored. No abstract syntax must be learned. Configuration of automatic operation is as easy as drawing a track diagram.

The number, range and complexity of activities that can be managed by one person is extended substantially. A broad range of operating flexibility is provided that extends from a completely manual operation through a completely automatic operation (e.g. hidden yards control). Manual and automatic operations can be mixed simultaneously. This applies not only to trains on different areas of your railroad, but also to different trains on the same track, and even to the operation of a single train. The automatic processes are not bound to specific trains. Once specified, they can be performed by each of your trains. Timetable and randomizer functions increase the diversity of your model railroad traffic.

2.2 Fundamentals of Use

The Overall Principle

The concept of **Rocomotion** is intended to support manual, semi-automatic and automatic operation of your model railroad as well as mixing of manual and automatic operation.

The *Switchboards* and the *Train Windows* provide the controls to operate switches, signals, routes and trains, etc. These controls can be operated manually by the human operator or automatically by the computer.

A human operator is normally only able to operate the switchboard and at most two trains at the same time. If a certain number of trains are to be operated at the same time, then either support of additional human operators is required, or a computer running **Rocomotion**. The software contains a special component called the *Visual Dispatcher*, which is able to take the place of additional human operators.
Like a human operator the Visual Dispatcher is able to operate switches, signals, routes and trains. This is called automatic operation.

Manual and automatic operation can be mixed like several human operators can cooperate to control the same layout.

You can also decide to do without the Visual Dispatcher, if you want to control everything yourself.

**File Handling**

The complete data of your model railroad layout is stored in one single file on the hard disk on your computer. This file is called layout file. You can create as many layout files as you like. This is for example useful if you have different model railroad layouts or if you want to try and store several variants of the same layout file.

The layout file contains the complete description of your layout, i.e. all track diagrams, routes, trains and all data specified for automatic control of the layout, if any. Please note that all data of the same layout is to be stored in the same layout file.

Layout files are created, opened and stored through the Railroad menu of the software.

Whenever a session is terminated by closing a layout file or by terminating the complete software then an additional file is automatically created called status file. The status file contains the current status of your model railroad layout, i.e. the current state of all switches and signals, the status and positions of trains, etc. The status file is loaded again when the program is started the next time. Using the content of the status file the software is able to start with the status of the model railroad valid at the end of the previous session.

**Window Handling**

Normally you will open several windows within the same layout file. If you want to control different trains with different train windows then you can open additional windows within the same layout file.

Additional windows are created and destroyed through the Window menu of the software. Each window can be made invisible at any time without loss of data.
The main window always contains the switchboard. Each additional window can be docked to the frame of the main window. In this case it is always moved or resized with the main window. Alternatively it is possible to place each additional window independently from the main window at arbitrary positions on the computer screen.

Please note the difference between windows and files. Only one layout file can be opened at the same time and the layout file contains all data and windows that belong to the same layout. The windows belonging to the same layout are contained in one layout file.

Diagram 32 shows an open layout file that contains several windows. The file contains among others a switchboard window, two train windows and a Dispatcher window for automatic operation.

**Edit Mode**

All changes to be made to the content of your layout file require that Rocomotion is running in edit mode. While edit mode is turned on you can change data, add new data or delete data, that is no longer needed. During operation edit mode is turned off. This protects your data during operation against unintentional changes.

Edit mode can be turned on or off at any time. When edit mode is turned on all automatic operation of your layout, if any, is stopped, though.

!!! In order to input new data as well as to edit or delete existing data edit mode must be turned on. !!!!

**Further Steps**

In order to control your model railroad layout with Rocomotion, you need the ROCO digital system with computer interface. The digital system is connected to an available USB or serial port of your computer.

In the following it is assumed that you are already familiar with the usage of your digital system. For details regarding your digital system, please refer to the documentation provided by the manufacturer.

To create a computer control system with Rocomotion the following steps are usually performed:
• Creation of the Switchboard containing a control panel based on a track diagram of your layout
• Entering the data of existing engines and trains
• Creation of automatic schedules

It is not necessary to perform all steps listed above to control your model railroad with Rocomotion. For model railroad clubs, it may be sufficient to arrange the Switchboards only. In this case, one person may be responsible for controlling the traffic by operating switches, signals and routes while other persons are using handheld throttles to control the trains. If you have an existing control panel, then you can use the Train Windows, independently, to take advantage of the realistic train control features of the program.

The Switchboard

Usually, you will start configuring Rocomotion by creating the Switchboard. Like at real railroads, the Switchboard is a control panel to be used to control switches, signals, routes and other accessories like uncouplers or crossing gates. The Switchboard is made using symbol elements representing tracks, switches, crossings, signals, routes and more.

You first insert track elements into the Switchboard to create a track diagram that represents the track plan of your layout.

After you have placed all tracks, switches, crossings and bridges in the correct positions, you specify the digital addresses of your switches.

When this has been done, you are already able to control the switches of your model railroad with Rocomotion and your computer.

Your model railroad may contain not only tracks and switches but also signals and other accessories. If so, the next step is placing the signals at the appropriate locations of your control panel. Rocomotion provides symbols for two, three and four aspect signals. Uncouplers, lights, crossing gates or other accessories can be controlled with symbols representing push buttons, toggle switches or on-off switches.

After you have placed all the signals in the correct positions, you specify the digital addresses of your signals and other accessories.

Once you have specified the digital addresses of your signals and other accessories, you are able to control these objects manually with Rocomotion, also.
Another possibility is to control your switches and signals by using *route elements*. Route elements are able to control groups of switches and signals. Additionally, route elements are locked until the specific route is released.

*Text elements* can be inserted at arbitrary positions to label your control panel. Images can be placed in the Switchboard as well.

If you want to control your trains automatically, then you will insert *traffic boxes* into your switchboard, that represent the blocks of your model railroad.

**Train Windows**

The *train window* enables the operation of your *engines* and *trains*. To control several trains simultaneously, you can open as many train windows on your computer screen as desired.

After the selection of the current engine, or train, in the train window, you are able to control the train and monitor its operations with the control instruments.

In order to be able to run your engines, it is sufficient to enter them as *engines* in *Ro-comotion* and to specify their *digital addresses*.

To operate a certain engine on your layout, just create a *Train Window* and specify the digital address of the engine. You do not have to bother with all other options until you want to add more realism to the operation of your trains.

**The Visual Dispatcher**

The *Visual Dispatcher* is a component that makes large scale railroad operations manageable by one person, matching operations found on the largest club layouts. *Engines* and *trains* can be operated manually or automatically.

Like a human operator must know the overall structure of the model railroad layout the *Visual Dispatcher* needs to know this, too. This structure is represented by a diagram that contains blocks and routes and the track connections between them. This diagram is called *main block diagram* of the layout. The main block diagram describes the track layout of your entire model railroad in rough outline.

The *Visual Dispatcher* manages traffic flow using a blocking system. Blocking ensures that trains do not collide and supports the tracking of train positions. For this purpose,
the railroad layout is divided into virtual, logical blocks. That means, you define blocks at locations where traffic control will take place (e.g. scheduled stops in a station).

Usually each track in a station or hidden yard, each siding and appropriate sections of the connections between two yards will form a block.

Dividing the layout into logical blocks does not necessarily imply, that your blocks must be electrically insulated. **Rocomotion** does not require such electrical insulation. It solely depends on the used hardware, whether your blocks must be insulated or not.

*Blocks, routes* and connecting *links* are arranged graphically in the *main block diagram* to specify on which paths trains will travel. *Schedules* describe train movements, i.e. how trains travel. This includes start and destination blocks, scheduled waits, speed limits, etc.

**AutoTrain™**, an outstanding feature of **Rocomotion**, allows you to start trains automatically without the need to define a schedule before or to create new *schedules* while playing with your trains – programming while playing!

Trains can run under full manual control, in which case the human *operator* will be responsible for obeying the block signals set by the *Dispatcher*; or under full control of the computer; or even with an intermediate level of automation.

*Schedules* can be arranged with a broad range of flexibility.
3 The Switchboard

3.1 Introduction

Rocomotion displays a switchboard in the main window of the software. The switchboard represents a track diagram control panel of your model railroad, i.e. those parts that contain switches, and signals. Examples of such areas are stations, sidings or hidden yards.

The Switchboard is used to operate the switches, signals, routes and other accessories, like crossing gates, on your model railroad. The Switchboard is created using different symbol elements that are arranged in rows and columns.

Several types of symbol elements are provided to facilitate in the creation of the switchboard:

- *Track elements* are used to represent the tracks of your model railroad such as straight and curved tracks.
- *Switch elements* are provided as special track elements to enable operation of different types of switches like normal, triple or slip switches.
- *Signal elements* are used as two, three or four aspect signals to represent and to operate the signals on your model railroad.
• *Accessory elements* of several types – *push buttons*, *toggle switches* or *on-off switches* – operate additional accessories such as uncouplers or lights or can be used to trigger other actions like playing of sound files.

• *Route elements* enable manual route operation and locking.

• *Traffic Boxes* are used for setup of automatic operation and display of train positions.

• *Text elements* can be used as labels, e.g. for tracks in stations.

• *Images* can be inserted into your track diagrams to display landscapes, buildings, streets or other objects of your model railroad.

The following steps are performed to create a full functioning switchboard:

• Drawing the track diagram of the related area

• Connecting switches and signals

• Placing signals and accessory elements

• Creating manual routes

• Inserting traffic boxes

• Adding text labels and images

3.2 Drawing the Track Diagram

Creating a *switchboard* starts with drawing the track diagram of the related station, yard or sidings. Using the available *track elements* a schematic image of the tracks of the area is drawn on the computer screen.

The following track elements are available:

• *Straight*

• *Normal or narrow Curve*

• *Bumper*

• *Diagonal or vertical crossing*

• *Diagonal or vertical bridge*

• *Turntable symbol* without electrical function

• *Left or right switch* as well as well as *Y-Switch*

• *Triple switch*

• *Single or double slip switch*

You can draw your track diagram in various ways. First, though, the edit mode of the switchboard must be turned on.
Then you have the following possibilities:

- **Inserting single elements:** You can draw your track diagram by inserting single elements successively.
- **Drawing a straight track section with the mouse:** You can draw a straight track section consisting of more than one element very quickly by dragging the section you want to draw with the mouse.
- **Drawing the track diagram with the keyboard:** An additional and fast way to draw the track diagram is the use of the numeric keypad of your computer.

These methods are explained in detail in the help menu.

To adjust the track elements precisely, additional edit facilities such as *copy*, *move* or *turning* of track elements are available.

### 3.3 Connecting the Switches

When the track diagram is completely drawn, the *digital address* of each switch, or slip switch, must be specified. This is the address of the stationery decoder or output device controlling the specified switch.

This is done by selecting the switch element and using the **Properties** command of the **Edit** menu.

For each switch you can specify a *name*. This is useful in identifying the switch when it is referred to later.
Switches with more than two states such as *triple switches* or *single or double slip switches* with four solenoids, occupy two digital addresses. For simplicity, *Rocomotion* always uses the subsequent address here, too.
For *double slip switches* it is possible to specify whether the switch is operated by two or four solenoids.

Depending on the way the switch is wired, the switch element in the switchboard may not reflect the correct position of the real switch. To correct this problem, you are not required to rewire your switch. The software allows to setup the configuration of the decoder outputs in any way as required to operate the switch accordingly.

---

**Diagram 36: Decoder Configurations for a double slip switch**

The image above displays two possible configurations for a double slip switch. In both cases it is assumed that the switch is operated by two double-solenoid devices with four solenoids in total. For this reason the switch occupies four output contacts of an accessory decoder. The left image displays a situation, in which both double-solenoid devices must be operated in order to throw the switch. The right image displays a situation, in which only one double-solenoid device is to be operated to throw the switch. The bright circles represent the contact outputs of the accessory decoder which are turned on in order to throw the switch to the corresponding state. The dark circles correspond to the decoder outputs, which remain turned off during operation of the switch.

The bright circles are drawn in a color, which reflects the color of the key, that is to be pressed on the ROCO Route Control in order to activate the related contact output. If you are familiar how to operate a certain switch with the Route Control then these additional markings help you to map the keyboard operation to the correct configuration in the software.

These images display only two possible situations. The decoder outputs can be configured very flexible as required to operate the switch accordingly.
3.4 Signals and Accessories

After completing the track diagram, the next step is to place the signals in the diagram, as well as the accessory elements such as operating lights, uncouplers or other accessories.

The following elements are provided:

- *Two, three and four aspect signals* of different styles
- *Push buttons, toggle switches* or *on-off switches* to operate your accessories

![Diagram 37: Attaching signals and accessories to the track](image)

If you want to visualize that a signal or accessory element located in the track diagram is associated with a piece of track on your railroad (for example a signal that controls a track section or a push button that operates an uncoupler), you can *attach* this element to a track element. For the operation of the signal or accessory element, however, it is not important if it is attached to the track or not. The purpose of the attachment is only to visualize the relation between the signal, or accessory element, and the corresponding track.

**Signals**

It is important for the operation of the signal that you differentiate between the symbol for a *two, three or four aspect signal*.
Diagram 38 shows signal symbols that are rotated according to the track elements they are attached to.

**Accessories**

*Accessory elements* are used to control accessories like uncouplers, light or crossing gates. They are available in three different types:

- *Push buttons* are used to turn on a certain contact temporarily – e.g. to control an *uncoupler*
- *Toggle switches* are used to change permanently between two related contacts
- *On-off switches* are used to turn on and off a certain contact permanently – e.g. to turn on and off lights

**Connecting Signals and Accessories**

Signals and accessories are connected to their real counterpart on the model railroad much like the switches as outlined in section 3.3, “Connecting the Switches”. This is also done by selecting the symbol of the signal, or accessory, in the switchboard and using the **Properties** command of the **Edit** menu.

**3.5 Routes**

*Rocomotion* provides *route elements*, which are used to operate and lock the *tracks, switches* and *signals*, that belong to a certain *route*. Routes are represented in the switchboard by route symbols that are operated like an *on-off switch*. If the route is turned on, then all switches and signals of the route are operated. All track elements and signals along the path of the route remain locked in this position until the route element is turned off again. As long as these elements are locked, they cannot be operated or used by other routes.

**Manual Routes vs. Automatic Routes**

*Rocomotion* distinguishes between *manual routes* and *automatic routes*. Automatic routes are operated automatically by the *Visual Dispatcher*. Manual routes can only be operated through their route symbol. They cannot be operated automatically by the *Visual Dispatcher*. 
A manual route is created by inserting a route symbol into a switchboard at an arbitrary location. The location of the route symbol in a switchboard does not matter. Especially the location of the route symbol must not relate to the location of the tracks, switches and signals contained in this route. Manual routes are created, if the Visual Dispatcher is not being used at all or for those areas of your layout, which are only controlled manually with switchboards but not with the Visual Dispatcher.

Please note the difference between route symbol and route in the switchboard. The route describes, which tracks, switches and signals are contained in a route. These elements are always located in switchboards. The route symbol represents a route.

Automatic routes are created automatically (for more details see page 69).

**Recording of manual Routes**

The most important action when creating manual routes is recording the path of the route. This is done by selecting the route symbol and using the Properties command of the Edit menu. In the following dialog, select the tab labeled Route and then press the button labeled Record.

This procedure starts the switchboard recorder and the path of the route can be recorded. The running switchboard recorder shows the small control panel displayed below:

![Diagram 39: The control panel of the switchboard recorder](image)

The control panel contains four buttons with the following meaning (from left to right):

- **Break**: Recording is interrupted and no elements are recorded until this button is pressed once more
- **Stop with Save**: Recording is terminated and the recorded elements are stored.
- **Cancel**: Recording is terminated and the recorded elements are not stored.
- **Help**: Display help information about the recorder.

After starting the switchboard recorder, you are able to record the route. First select the switchboard in which the intended path of the route is located. Then, click to the track where the route will begin. Finally, click to the track element, where the route will end. Rocomotion displays the tracks along the route as if the route were activated, but only if it is possible to reach the destination track from the starting track.
If you specify the start and end of a route in this way, then Rocomotion tries to find an arbitrary suitable path. Alternatively, you can also specify a path from the start to the destination of the route. To do this, move the mouse to the starting track. Press and hold the left mouse button and drag the mouse along the desired path to the destination of the route. After reaching the destination release the left mouse button. Again Rocomotion indicates the tracks along the route as if the route were activated.

To extend an existing route, additionally press and hold the Shift key during the procedure outlined above.

3.6 Text Labels

You can place text labels in your control panels. For this purpose, text elements of the following types are provided and can be used to label switches, signals or tracks.

3.7 Images

It is possible to insert images from bitmap files into your switchboard. The following possibilities are provided:

Images can be arranged in the background, i.e. behind the track diagram, or in the foreground of the switchboard. Images in the background can be covered by track elements or by images laying in the foreground. Such images can be used to display landscape structures like meadows or rivers. Images in the foreground can cover track elements and can be used to display buildings, bridges or tunnels.

It is additionally possible to fade out portions of an image, i.e. to draw portions “transparently”. This is useful if images with irregular shapes are drawn. This is done by drawing the parts of the image, which shall be drawn transparently, with a certain color, which is not used elsewhere in the image.
In the first example displayed above the image is not drawn transparently. All parts of the image are visible in the preview. In the second example the white parts of the image are drawn transparently and remain invisible.

### 3.8 Displaying Train Names and Symbols in the Switchboard

The names or symbols of trains located in a certain block can be displayed in the switchboard with so called traffic boxes. These are elements, that are associated with blocks. Traffic boxes are able to show the status of the related block as well as an image and/or the name of the train that is currently located in the block, if any. For further details please refer to section 6.5, “Train Tracking”.

Traffic Boxes are also needed for setup of automatic operation of your trains. These boxes mark the location of the blocks of your layout in the track diagram.
4 Train Control

4.1 Introduction

The *Train List* and *the Train Windows* provided by *Rocomotion* are used to manage and operate your engines and trains.

The *Train List* holds all engines and trains defined in the software.

Each item in this list shows the name and the image of the train. To prepare train images for display in *Rocomotion* a complementary software program called *TrainAnimator™* is available free of charge.

*Rocomotion* expects the image data to be stored in a certain format and scaled to a certain size. The images must fit to the proportions of the screen display of *Rocomotion*. Additionally the images of several trains should fit to each other with regard to their scale, regardless of the origin of each image. *TrainAnimator™* is able to process sev-
eral image formats, among others bitmap, JPEG or GIF. It is also able to extract images, that are stored in application programs or screen savers. **TrainAnimator™** converts the different data formats and image sizes to a standardized and scaled format, which can be used by **Rocomotion** without further conversion.

The images displayed in Diagram 42 have been processed with **TrainAnimator™**, too. Even though the original formats and sizes of the particular images displayed above are very different, they have been converted and scaled to fit to each other.

In the **train list** each engine or train can be selected to change its properties or to operate it. If, for example, a double-click is performed to a train in this list during operation of the layout, then a **Train Window** is being activated with which the train can be operated.

A sample **Train Window** is displayed below:

![Train Window Diagram](image)

Diagram 43: Train Window

All engines and trains defined in the software are listed in all Train Windows, too. If a train is created in a certain Train Window, then this train is listed in all other Train Windows, too. It does not matter in which Train Window the properties of a train are changed or with which Train Window a train is operated. The changes of the properties or of the status are reflected in all other Train Windows also.
4.2 Engines and Trains

An *engine* describes different properties of one of your model engines. These are prototypical attributes like maximum speed, or model related properties like digital address or auxiliary functions.

For simple operation of your engines it is sufficient to enter each engine with its *digital address* in *Rocomotion*. To specify the digital address or other attributes mark the appropriate engine in the Train List or in a Train Window and select the *Properties* command of the *Edit* menu. Once an engine is entered with its digital address it is then possible to control it with the Train Window.

![Diagram 44: Digital Address of an Engine](image)
4.3 The Throttle

The throttle is used to control the speed of each engine or train. The zero position of the throttle is located in the middle. When the slider of the throttle is in the rightmost position, the train is running forward with maximum speed. Conversely, the maximum backward speed is achieved by pulling the slider to the leftmost position.

For each engine you can specify the maximum scale speed. This value is used as the maximum speed with which a train is controlled by Rocomotion. To run an engine with maximum speed the throttle slider must be pulled to the rightmost or leftmost position.
For each engine you can also specify the threshold speed. This is the minimum speed at which the engine runs smoothly. The threshold speed is used if the throttle slider is moved out of the zero position. In this way “dead zones” near the zero position of the slider are avoided. For engines which will run automatically under control of the Dispatcher (see chapter 6, “The Visual Dispatcher”) it is recommended to adjust the threshold speed accordingly.

### 4.4 Speedometer and Odometer

The speedometer displays the current scale speed of an engine or train. The scale speed is calculated using the real speed on the model railroad layout and the scale of the model. If a train with scale 1:87 (H0) is running with a real speed of 1 mile per hour on the model railroad layout, then this speed corresponds to a scale speed of 87 miles per hour.

Using a certain scale factor the simulated distance is calculated. This simulated mileage is displayed on the odometer.
4.5 Automatic Speed and Brake

To enable the program to display the correct scale speed on the speedometer and to perform speed calculations correctly during automatic operation it is recommended to adjust the speed profile for each engine.

The speed profile is a table that records which virtual speed step corresponds to which scale speed. Rocomotion internally works with 1000 virtual speed steps for each direction regardless of the characteristics of the used engine decoder. When a speed command is sent to the decoder, then the virtual speed step is matched to the appropriate physical speed step of the decoder.

The Speed Profile

The speed profile describes the speed characteristics of your engine very roughly and with identical settings for both directions of travel. It contains the following entries:

- An entry, that describes the threshold speed. This is the minimum virtual speed step (out of 1000) at which the engine begins to run smoothly. This value is adjusted by letting the engine run as slow as possible, but also smoothly. If this is achieved the current speed value is stored into the software.
- An entry describing the speed step, that corresponds to a pre-set slow speed. Let the engine run at this speed (e.g. by measuring the speed with a stop watch) and store this value into the software.
- An entry describing the speed step, that corresponds to the maximum speed of the engine. This value is determined and stored in the same way as the other two values.
- An entry describing the braking ramp, that is effective, when the engine is stopped during automatic operation. If the engine is decelerating too slowly or stopping too late during automatic operation, then this value can be easily adjusted.

Before adjusting the speed profile the decoder of the locomotive should be prepared accordingly. This should be done to achieve the best possible operation. Perform the following steps prior to adjustment of the speed profile:

- Set the start voltage to a value, at which the locomotive begins to run smoothly.
- Adjust the maximum speed of the decoder in a way, that the desired maximum scale speed of the locomotive corresponds to the highest speed step of the decoder. If, for example, your decoder has 28 speed steps and the maximum scale speed of the locomotive should be 100 mph, then adjust the maximum speed of the decoder in a way, that the locomotive runs about 100 mph at speed step 28.
• Set the deceleration momentum of the decoder to a minimum value. This is just the value, at which now abrupt speed change of the real locomotive can be noticed anymore, when changing from one speed step to another.
• Adjust the speed table or the mid voltage of the decoder, if any, and its acceleration momentum to any settings, that you feel convenient with.

Note, that the speed profile must be adjusted again, whenever you changed the maximum speed, the deceleration momentum, the start or mid voltage or the speed table of the decoder.

4.6 Headlights, Steam and Whistle

For each engine up to nine auxiliary engine functions (e.g. light, sound, smoke, etc.) can be defined. Each function can perform one of the following:

• activating a built-in function of an engine decoder
• playing a sound file

Engine Functions are executed manually by using the auxiliary function controls of the train window.
You can specify an individual *tip* for each function. This is arbitrary text which is displayed in a small popup window, when the mouse is moved over a function button in the *Train Window*. This tip text helps to distinguish between different functions that are associated with similar function symbols (such as *Light 2*, *Light 3*, …).

The actually executed function may be different from engine to engine. This is illustrated by the following example. It is assumed, that a built-in sound function of the corresponding engine decoder is assigned as *Sound 1* to a diesel engine and playing a sound file with a typical sound of a steam engine is assigned as *Sound 1* to a steam engine. If the function *Sound 1* is executed, then the built-in decoder function is activated for the diesel engine and the specified sound file is played for the steam engine.

Each function, which is assigned to a built-in function of an engine decoder can be turned on permanently (e.g. *Light* or *Steam*) or temporarily (e.g. *Whistle* or *Coupler*). For this reason the auxiliary function controls in the train window can be arranged as on/off switches or push buttons.

![Diagram 48: Arranging Auxiliary Functions](image)

**4.7 Acceleration and Train Tonnage**

An additional feature of *Rocomotion* is the realistic simulation of *momentum*, i.e. *acceleration* and *deceleration* of engines and trains.
For each *engine* you can specify separately the acceleration and deceleration momentum. These values are stored in the software only. They do not change the configuration settings of the decoder.

### 4.8 Passing control between Computer and Digital System

Initially control of each *engine* is assigned to the computer. This means that the software assumes that it has full control over the engine.

With specific menu commands, it is possible to pass control from the computer to the digital system and vice versa.

If control is passed from the computer to the digital system then control of the related digital address is passed to a handheld of the digital system, if necessary. Additionally, *Rocomotion* begins to monitor speed and function changes of this engine and reflects such changes in the Train Window accordingly.

**For train tracking (see section 6.5, “Train Tracking”) of an engine it is important that the software knows the direction and speed of a running engine. If you want to control an engine with a handheld of your digital system under simultaneous train tracking, then it is necessary to assign control of the engine to the digital system before.**

If an automatic schedule of the Dispatcher (see section 6.10, “Schedules”) is executed with an engine currently under control of the digital system, then control of this engine is temporarily passed to the computer. After finishing the schedule control is passed back to the digital system. Such transfers of control are performed by the software automatically if needed.

**Assigning control of an engine to the computer is therefore only necessary, if you want to control the engine manually with the on-screen throttle.**
5 Contact Indicators

In conjunction with the feedback module the ROCO computer interface is able to report the state of track contacts, reed contacts, optical sensors, track occupancy sensors or other feedback sensors to the computer. With the help of contact indicator symbols you are able to monitor the state of the feedback sensors on the computer screen.

Contact indicators are always needed for automatic control of your layout with the Visual Dispatcher (this is outlined in detail in the sections 6.6 - 6.8).

Feedback sensors are distinguished between momentary track contacts and occupancy sensors. In Rocomotion the same symbol is used for both types of contacts.

Momentary Track Contacts vs. Occupancy Sensors

Momentary track contacts are turned on for a short moment, when a train passes a certain point on the model railroad. They stay turned on only for a short moment and are turned off as soon as the train moves any further. In Diagram 49 to Diagram 51 you can see a momentary contact triggered by a passing train. Momentary track contacts indicate that a train is about to pass a certain point. Occupancy sensors are turned on when a train enters a certain section on the model railroad. They stay turned on until the train leaves that section completely. Occupancy sensors indicate that a train is located inside a certain track section. In Diagram 52 to Diagram 55 you can see an occupancy sensor turned on and off by a passing train. Occupancy sensors are able to report the presence of a train inside a certain track section even if the train is not moving. Momentary contacts are triggered by moving trains only. Momentary contacts can be made for instance by mechanical track contacts, reed contacts or optical sensors. Occupancy sensors are often based on current sensing in isolated track sections.

Unlike other programs which require occupancy sensors for automatic train control Rocomotion is also able to control trains if only momentary track contacts are used. Occupancy sensors are more safe, though, because with momentary contacts special measures against premature release of blocks and routes must be taken.

The following diagrams show the behavior of a momentary contact in the different phases while a train is passing. The position of the momentary contact is marked with a short vertical line. This line is drawn in bright red when the contact is turned on.
The following diagrams show the behaviour of an occupancy sensor in the different phases while a train is passing. The track section sensed by the occupancy sensor is marked with a horizontal line. This line is drawn in bright red while the sensor is turned on.
Diagram 52: Train is approaching the occupancy sensor – the sensor is turned off

Diagram 53: Train is located inside the sensed section – the sensor is turned on

Diagram 54: Train is still located inside the sensed section

Diagram 55: Train has left the sensed section – the sensor is turned off

There is one major difference between momentary contacts and occupancy sensors to remember: the points at which the indicators are turned on. A momentary track contact
is turned on when a train reaches a certain point on the layout regardless of the direction of travel of the passing train. In this way a momentary track contact represents one single sensing point on the model railroad. An occupancy sensor is turned on when a train reaches either end of the sensed track section depending on the current direction of travel of the passing train. In this way an occupancy sensor represents two different sensing points on the model railroad. It depends on the direction of travel of a passing train at which of these two points the train triggers the sensor.
6 The Visual Dispatcher I

6.1 Introduction

A human operator is normally only able to operate the switchboard and at most two trains at the same time. If a certain number of trains are to be operated at the same time, then either support of additional human operators is required, or a component like the Visual Dispatcher, which is able to take the place of additional human operators.

The Visual Dispatcher (or in a word Dispatcher) is a component that makes large scale railroad operations manageable by one person, matching operations found on the largest club layouts.

Like a human operator the Visual Dispatcher is able to operate switches, signals, routes and trains. This is called automatic operation.

A broad range of operating flexibility is provided from completely manual through fully automatic operation (e.g. hidden yards control). Manual and automatic operation can be mixed simultaneously. This applies not only to trains on different areas of your railroad, but also to different trains on the same track and even to the operation of a single train. Automatic processes are not bound to specific trains. Once specified they can be performed by each of your trains. There is no need to learn a programming language. Random functions increase the diversity of your model railroad traffic. Built-in train tracking functions display on the screen which engine/train is on which track.

Like a human operator must know the overall structure of the model railroad layout the Visual Dispatcher needs to know this, too. This structure is represented by a diagram that contains blocks and routes and the track connections between them. This diagram is called main block diagram of the layout. The main block diagram describes the track layout of your entire model railroad in rough outline.

The Visual Dispatcher manages traffic flow using a blocking system. Blocking ensures that trains do not collide and supports the tracking of train positions. For this purpose, the railroad layout is divided into virtual, logical blocks. That means, you define blocks at locations where traffic control will take place (e.g. scheduled stops in a station). Usually each track in a station or hidden yard, each siding and appropriate sections of the connections between two yards will form a block.
Blocks are arranged graphically and connected by routes and links to specify on which path a train will travel from certain starting blocks to destination blocks. Schedules describe train movements, i.e. how trains travel. This includes scheduled waits, speed limits, etc.

Trains can run under full manual control, in which case the operator will be responsible for obeying the block signals set by the Dispatcher; or under full control of the computer; or even with an intermediate level of automation.

For shunting special types of schedules are provided. Schedules can be arranged with a broad range of flexibility. Random functions increase the diversity of your model railroad traffic.

Creating a model railroad operation system with the Dispatcher is done by performing the following steps:

- Divide the model railroad layout into blocks and enter these blocks into the switchboard of Rocomotion
- Rocomotion automatically creates the main block diagram of your layout This diagram represents the track layout of your entire model railroad in rough outline.
- Arrange schedules.

These steps will be outlined in more detail in the following sections. We will do this by looking at the following sample layout:
The layout has two stations: “Southtown” located on the left side of the layout and “Northville” located at the end of a branch line. There is an additional hidden yard that is covered by the mountain.

This can be seen better in the track plan displayed below:
Diagram 57: Track Plan of the Sample Layout

The main line, i.e. the loop that connects “Hidden Yard” and “Southtown”, will be operated automatically under full control of the Visual Dispatcher. The branch line from “Southtown” to “Northville” will be operated manually.

The parts of the layout, that are covered by structure and therefore invisible, are drawn here in a slightly brighter colour.

The first step is drawing of a switchboard for the layout displayed above. It looks as follows:
The next steps, that are required to configure this layout in the *Visual Dispatcher*, are outlined in the following sections.

### 6.2 Blocks

#### Blocks on the Layout

The *Visual Dispatcher* manages traffic flow using a *blocking system*. Blocking ensures that trains do not collide. For this purpose the railroad layout is virtually divided in logical blocks. That means, you define blocks at locations, where traffic control shall take place (i.e. stopping inside a yard) or where trains are parked. Blocks are also used to determine and to indicate the position of your engines and trains on your tracks.

Typical examples of blocks are

- Tracks at a platform
- Sidings in a (hidden) yard
- Block sections on tracks between two stations
In most cases blocks contain only a straight track section and no turnouts. They are usually limited by two turnouts on both sides or by a turnout and a dead end of the track. Block sections between two stations are often limited by block signals.

Some guidelines for arranging your blocks:

- Blocks may be located anywhere on your railroad.
- Blocks are often limited by turnouts. These turnouts usually do not belong to the blocks.
- Blocks should be long enough to hold each stopping train completely.
- Each location, where the Visual Dispatcher shall be able to stop a train automatically (e.g. in a station or in front of a signal), should be located in a separate block, i.e. in order to stop two trains at the same time at different locations, these locations must be arranged in different blocks.
- The more blocks are provided the more trains can be run simultaneously under control of the Visual Dispatcher.
- Each block can be reserved by at most one train. A specific train may reserve several blocks. A train, that runs under control of the Visual Dispatcher, may enter blocks only, that are reserved for this train.
- Blocks must be provided only for the parts of your model railroad, which shall be controlled by the Dispatcher. Parts without blocks are not visible for the Dispatcher.

Following these guidelines the block structure of the sample layout looks as follows:

![Diagram 59: Block structure of the sample layout](image-url)
Each blue track section represents a separate block. The blocks on the main line or the branch line between “Southtown” and “Northville” can be subdivided any further into more blocks if each of these blocks is long enough to store the longest train. This is useful if you want more than one train to travel on these tracks at the same time.

**The Main Block Diagram**

Like a human operator must know the overall structure of the model railroad layout the Visual Dispatcher needs to know this, too. This structure is represented by a diagram that contains blocks as well as the routes and track connections (links) between blocks. If there are turnouts to be thrown in order to let a train run from one block to an adjacent block, then the blocks must be connected by appropriate routes (see section 3.5, “Routes”). This diagram is called main block diagram of the layout. This diagram describes the track layout of your entire model railroad in rough outline.

The block diagram is automatically created by the software. Rocomotion uses the track diagram of the switchboard, that is contained in the main window of the software, as base of calculation of the block diagram. For this purpose it is necessary to specify the positions of the blocks in this track diagram. This is done with the help of so called traffic boxes. Each traffic box represents a block in the track diagram of the switchboard. For each block determined in Diagram 59 a traffic box is created and added to the switchboard in Diagram 58. The result is displayed in the following diagram:
The software automatically calculates a block diagram, that is displayed in the *Visual Dispatcher* as shown below:
Blocks are displayed on the computer screen by rectangular boxes. The blocks are connected by routes or links. These routes or links are drawn as lines. Since there are turnouts to be operated in this example in order to travel from one block to the next each two blocks are connected by a route. These routes are created and recorded automatically by the software (see also Section 3.5, “Routes”).

Routes are inserted automatically between two blocks, when the software detects the symbol of a turnout or crossing in the track connection between both blocks.

Please note that the block diagram represents the track layout in rough outline. The actual track connection between “Main Line West” and “Hidden Yard 3”, for example, contains two switches. These switches are not drawn in the block diagram in detail or as separate objects. Instead a link between both blocks is created, that indicates, that there is a track connection between both blocks.

In order to enable Rocomotion to calculate the block diagram automatically note the following:
• Draw the complete track diagram of your layout with all turnouts and crossings and without any gaps in the switchboard.
• Create traffic boxes for all blocks of the layout, place them according to their location on the actual layout and ensure, that they are turned horizontally or vertically according to the track symbols, to which they are attached.
• Ensure that the blocks are connected by track symbols without any gaps.

Links and Routes between Blocks

In order to let trains run from one block to another the blocks must be linked together. This is done with the help of links or routes. In the block diagrams links and routes are represented by lines that connect one block with an adjacent block.

Each block has two entries/exits. If a block is passed horizontally, then the entries/exits are graphically located on the left and on the right side of the block. If a block is passed vertically, then the entries/exits are located at the top and at the bottom. Each link or route begins at the entry/exit of a block and ends at the exit/entry of an adjacent block.

Routes are used to connect two blocks, if turnouts are to be thrown in order to allow a train to travel from one block to the other.

The following image explains the terms once more:

![Diagram 62: Blocks, Route and Link]

In the diagram displayed above the blocks “Southtown 1” and “Main Line East” are connected with a link or a route.

The necessary links and routes are automatically created according to the track connections between the blocks (traffic boxes) in the track diagram of your switchboard.

The main block diagram of the complete layout is drawn within one single diagram. The space provided by the software is not limited. In case of large layouts it is possible to zoom and scroll the window accordingly, in which the block diagram is displayed.
6.3 Direction of Travel vs. Engine Orientation

It is important to understand the difference between direction of travel and the orientation of an engine.

Direction of Travel

Direction of travel is seen from the passenger's point of view. For the passenger sitting in a train it is important to know, whether the train runs from the east to the west, from the city to the country, or from the sea to the mountains. The direction of travel has a “geographical” meaning. Each block can be passed in one of two directions at a time. For each train controlled by the Dispatcher the Dispatcher must know the train's intended direction of travel. This information is derived by the Dispatcher from the arrangement of the blocks in the related diagrams and the links that contain these blocks.

Rocomotion draws each block to represent one pair of corresponding directions. Each block can be either passed horizontally (from the left to the right or back) or vertically (from the top to the bottom or back).

Diagram 63: Block Diagram of a Circular Layout

In the diagram displayed above the direction of travel of each block is here indicated by an arrow. Rocomotion does not display these arrows, though, but displays small signal symbols on two sides of each block, to mark the direction of travel, that belongs to the block.
The direction of travel will correspond to the drawing of the block in the diagram. A block that is passed horizontally will be drawn as a horizontal rectangle while a block that is passed vertically will be drawn as a vertical rectangle. This is shown in the diagram displayed above.

**Engine Orientation**

*Engine Orientation* is seen from the *engineer's* point of view. It is not important for the passenger. The engine orientation describes the direction of the engine's head. For an engineer, who has to run a train in a certain direction of travel it is also important to know the engine's orientation, i.e. the direction of the engine's head. Depending to the intended direction of travel and the engine's orientation the engineer can decide, whether the engine is to be run forward or backward.

When the *Dispatcher* runs a train, it acts like an engineer. Especially both information - the intended direction of travel and the engine's orientation - must be known by the Dispatcher to start the train accordingly.

The orientation of each engine is specified during assignment of an engine or train to a block. There are several methods to assign trains to a block. The most convenient method is to drag & drop a train icon to the traffic box or the symbol of a block. **Please check always that the current orientation of the engine matches the screen display.**

In case both do not match it is possible to revert the screen display with appropriate menu commands.

Another method for automatic assignment of trains to blocks is the use of train detection or train tracking (see 6.5, “Train Tracking”).

### 6.4 States of a Block

The different *states* of a block are determined by the fact whether the block is *occupied* or whether it is *reserved* for a certain *engine* or *train*.

**Occupied Block**

A block is assumed to be *occupied*, if at least one of the *indicators* assigned to the block is turned on.
Reserved Block

Each block can be manually or automatically reserved for an engine or train by the Dispatcher. Reservation serves to support the following goals:

- Since a block can be reserved only for at most one engine or train, train collisions are avoided if blocks are arranged and reserved correctly.
- The program is able to determine, in which block a certain engine or train is located. This enables operations tied to the locality of trains - for example stopping a train in front of a red signal.
- The use of traffic boxes allows indication of train positions in the switchboard.
- Train detection and train tracking is based on dynamic and automatic reservation of blocks, too (see 6.5, “Train Tracking”).

Current Block

Among the blocks, which are reserved for a train, there is a special block, where the head of the train is assumed to be located. This block is called the current block of the train. Through the current block all block related operations which affect the speed of a train (like running with restricted speed) are performed.

In the beginning you must manually assign each engine or train to its current block. Afterwards this assignment is adjusted automatically by Rocomotion according to the position changes of the affected trains. Even after terminating and restarting of the program this assignment is automatically updated. Only if an engine or train is moved by hand to another track you must assign the engine or train to its new current block again.
When an engine or train is assigned to its current block, then the current engine orientation must be specified. **Rocomotion** needs to know this orientation to be able to determine, if an engine runs forward or backward. **Rocomotion** adjusts the engine orientation accordingly even if an engine changes its orientation by passing a *reversing loop*.

**Rocomotion** provides several methods to assign a train to a block. The most convenient is to drag a train from the train list to the symbol of a block. The initial assignment of an engine or train to a block can also be done automatically without manual interaction, if a *train detection device* is used (see section 6.5, “Train Tracking”). If this device is associated with a *contact indicator* and this indicator is again assigned to a block then each engine or train detected by the train detection device will be automatically assigned to this block.

A reserved block must not necessarily be occupied. This is also true for the current block. If for example a train leaves its current block and temporarily no other blocks, that are reserved for this train, are occupied, then the current block is not changed, before the train enters another block and this block is indicated as occupied.
Display of Train Positions

The states of a block outlined are indicated by the concerning traffic boxes in the switchboard. In this way you can control in the switchboard, too, if a certain block is occupied or reserved. Traffic boxes display the name and/or the image of the train, that is currently located in the related block, in the switchboard. For further details refer to 6.5, “Train Tracking”, please.

Locking of Blocks

Each block can be temporarily locked during operation. Locked blocks cannot be reserved nor entered by running trains. A train, that is already located in a block, when the block is locked, might stay there, though, and leave the block later.

Please note that locking of a block affects all trains. Through the options of schedules it is possible to exclude specific trains from using a certain block.

Locking the exit of Blocks

Each exit of any block can be temporarily locked during operation. A block cannot be left through a locked exit. Trains may enter such blocks and may stay there, but they cannot leave a block through a locked exit.

It is possible to lock either exit of each block individually and independently from the opposite exit.

Please note that locking of a block exit affects all trains. Through the options of schedules it is possible to exclude specific trains from leaving a block.

6.5 Train Tracking

Rocomotion is able to indicate the positions of your engines and trains on the computer screen. This is always and automatically done. The traffic boxes in the switchboard display the state of the associated block and optionally the name and/or image of the train that is located in this block.
Whenever a block is reported as occupied, because one of the indicators assigned to it is turned on, then the Dispatcher checks, whether there is an appropriate train in an adjacent block. An adjacent block is a block that is connected with the current block with a link in the main block diagram.

If there is such train, then the train symbol is moved to this block. This is done by automatic assignment of the train to the new block and releasing of the previous block.

As a result of this movement the name and/or image of the engine or train appears in the block symbol of the related block in the Visual Dispatcher. Additionally the train disappears from the symbol of the previous block. If there are one or more optional traffic boxes in a switchboard window associated with these blocks, then the train movement will be visible in these boxes, too.

If there are more than one train located in adjacent blocks, than the Dispatcher tries to determine the most probable candidate. For this calculation the speed of each train and the direction of travel, if known, or the occupancy state of each adjacent block is taken into account.

In order to achieve precise results it is important to assign the initial position and orientation of each train correctly. Additionally you should always ensure that the software is able to track the direction and speed of each train. The control of trains that you operate with the throttle of your digital system should properly be assigned to the digital system (see 4.8, “Passing control between Computer and Digital System”).

- Under the conditions listed below train tracking works for each engine or train on the layout, which has been previously assigned to a block.
- The initial assignment of trains to blocks can be done manually or automatically by train detection. Train detection rids you from performing the initial assignment manually; train detection is no prerequisite of train tracking; though.
- Train tracking is based on the main block diagram of the Visual Dispatcher and follows the specified links between the blocks. The tracking of manually operated trains, such as those trains that you control with the throttle of your digital system, is
only possible, if an appropriate main block diagram is available, that contains the proper links between your blocks.

For train tracking of an engine it is important that the software knows the direction and speed of a running engine. If you want to control an engine with a handheld of your digital system under simultaneous train tracking, then it is necessary to assign control of the engine to the digital system before (see section 4.8, “Passing control between Computer and Digital System”).

### 6.6 Blocks and Indicators

For proper operation the *Dispatcher* must be able to detect, whether a train occupies a specific section of your railroad or when a train passes a specific point on your railroad. This detection is done with *contact indicators* (see section 5, “Contact Indicators”).

![Diagram 66: Assigning Indicators to Blocks](image)

In order to create a block all *indicators* that are located in the block are assigned to the block. If at least one of these indicators is turned on, then the block is assumed to be occupied. The actual layout positions of the sensors assigned to the block determine also the location of the block on your railroad. In order to have control over the exact location, where a train is to be stopped inside a block, you can mark certain indicators as stop or brake indicators (see section 6.7, “Stop and Brake Indicators”).
To establish a block on your railroad, it is necessary to install the required sensors. Depending on the principle of the used contact sensors it may be necessary to electrically insulate the track section belonging to a certain contact sensor from adjacent sections. Whether electrical insulation is necessary or not depends solely on the contact sensors being used. The software does not require electrical insulation of your blocks.

- The software does not require that a block is electrically insulated from other blocks. The used sensors might require this, though.
- Blocks usually contain several indicators. If these indicators represent isolated or separate track sections then several track sections are contained in the same block (see also 6.8, “Arranging Indicators in a Block”).
- The same indicator cannot be assigned to several blocks. Especially you should install your sensors on your layout in a way, that each sensor section is associated with at most one block.

## 6.7 Stop and Brake Indicators

A block is created by assigning several indicators to it. If at least one of these indicators is turned on, then the block is assumed to be occupied. The indicators are used for indication of occupancy. Additionally each indicator can act as brake indicator and/or stop indicator.

It may happen, that a train has to stop when passing a certain block. This is for example the case, when the block ahead is not available or when the train shall change its direction or when the train shall stop inside the block for a certain amount of time. In order to give you control over the exact location, where a train is to be stopped inside the block, you can specify certain indicators, which are assigned to the block, as stop or brake indicators.

Let us assume that a train approaches a certain block. That means, that none of the assigned indicators was activated before and that at least one of these indicators is activated now. If this indicator is neither a brake nor a stop indicator, the block is marked as occupied and the train continues with unchanged speed. If the train reaches an indicator, which is assigned as a brake indicator for the current direction of travel (see section 6.3, “Direction of Travel vs. Engine Orientation”) and the train has to stop inside this block, then the train is decelerated to its threshold speed (see section 4.3, “The Throttle”). The braking ramp can be set as desired individually for each brake indicator. If the train reaches an indicator, which is assigned as a stop indicator for the current direction of travel...

rection of travel and the train has to stop inside this block, then the train is stopped at once.

⚠️ Please note that a brake indicator is only effective if the train has to stop in the same block. As a consequence brake and stop indicators that belong together must be contained in the same block.

A stop or brake indicator can be valid for one or both directions of travel. It is even possible, that a certain indicator operates as a stop indicator in one direction and as a brake indicator in the opposite direction.

Diagram 67: How Brake and Stop Indicators work – Occupancy Sensors

Diagram 67 shows a block, which is equipped with three occupancy sensors. The left entries to the sensed track sections are marked with B1, B2 and B3.
Diagram 68: How Brake and Stop Indicators work – Momentary Track Contacts

An alternative, but for this discussion almost equivalent situation shows Diagram 68. It contains a block, that is equipped with two momentary contacts. These contacts are marked with B2 and B3, too.

B3 is defined as stop indicator (●) effective for trains travelling to the right. B2 is defined as brake indicator (■) effective in the same direction. B1, that applies only to the upper diagram, is neither defined as brake nor as stop indicator. B1 is used only for occupancy detection.

The red line shows the speed of the train. It is assumed that the train shall stop in this block, i.e. at B3. When the train enters the block at B1 nothing happens, because B1 is used only to report the entry into the block. When the train reaches B2, it is decelerated to its threshold speed. The braking ramp can be specified individually for each brake indicator. After deceleration the train proceeds at threshold speed until it reaches B3. When the train reaches B3, it is stopped without delay.

If the train does not have to stop in this block, then it passes all indicators without any speed change.

If the stop indicator B3 is missing, then the train will run with normal speed to B2 and stop there without delay. If no stop indicator is assigned to a block, then the first appropriate brake indicator is used as stop indicator. If only the indicator B1 is existing, then the train will already be stopped at B1. If necessary, a train is stopped in a block anyway, even if no brake and stop indicators are assigned.
This examples illustrates also, that proper operation of brake indicators requires correct adjustment of threshold speed of each affected train! If this is not the case, the train will be decelerated to an undefined threshold speed. Normally this speed will be too low, to run the train properly and the train will stop when reaching the brake indicator.

It is recommended to locate the sensors which correspond to the brake and especially the stop indicators near the exit of a block, because even long trains should completely fit into a block. If an engine or train passes a sequence of blocks and a certain block is not available or must be passed at restricted speed, then the train is stopped or decelerated in the previous block. Brake and stop indicators control, if a train may exit a certain block and at which speed it must enter and pass the following block. For this reason Rocomotion always assumes, that brake and stop indicators are located near the exit of each block with reference to the direction of travel they are effective.

If restricted speed applies in a certain block, then the train is decelerated at the first brake indicator of the previous block. If no brake indicator is assigned to this previous block or a stop indicator is reached first, then the train is already decelerated at the stop indicator. If neither brake nor stop indicators are assigned to this previous block, then the train is stopped when passing the first indicator in this block.

Rocomotion assumes that a train ready to be started is located with its head near the exit of its current block. It is also assumed that the train will exit its current block and enter the next block just after being started. For this reason any speed conditions of the first block are ignored and the train is accelerated to the speed, which applies in the second block.

All speed changes take place at the appropriate indicators of the previous block.

When a train enters a block, the Dispatcher checks if there is a route before the next block. In this case, the route is activated if this has not already been done. If the activation is not completed when the train reaches the brake or stop indicator in this block then the train is decelerated or stopped, respectively, in order to wait for the activation of the route. If there is only one indicator in this block, then the same indicator is used for indication of entry into the block, activation of the route and braking or stopping. In this case, the train is always stopped for a short moment because the activation of a route takes some time.

Such short stops can be avoided by adding at least one additional indicator to the block in order to indicate block entry and braking or stopping at different locations.
6.8 Arranging Indicators in a Block

This section describes the different types of sensors and how to use them to operate a block.

Arranging Momentary Track Contacts and Occupancy Sensors in a Block

In the following it is assumed that the track section between the switches in the diagrams displayed in the previous section is a block. Several methods to arrange indicators in a block are discussed below. The pros and cons of each method are outlined as well.

Diagram 69: Block with three occupancy sensors

Diagram 69 shows a block driven by three occupancy sensors. Each of these sensors is associated with a contact indicator in the software called A, B and C. All indicators are assigned to the same block in the software. The block is indicated as occupied as soon as a train enters section A from the left or section C from the right. The block remains occupied until the train leaves the opposite section. The indicator A is additionally used as stop indicator for trains running to the left, C acts as stop indicator for trains running to the right. The trains are stopped at the boundary between B and A or C, respectively. The indicator B is used as brake indicator for both directions. Trains begin to slow down when entering B from either direction. The sections A and C should be long enough, that each train is safely stopped before touching one of the switches. On the other side the longest train should completely fit into the block when being stopped. For this reason the boundaries between B and A or C, respectively, where trains are stopped, must be located close enough to the boundaries of the complete block.

The configuration displayed in Diagram 69 is the optimal solution from a pure technical point of view. The block is indicated as occupied as long as a train is located in one of the three occupancy sections. Additionally it would be even possible to distinguish in which of the three sections A, B or C a train is located. This method is also relatively costly, though, because occupancy sensors are usually relatively expensive and the rails must be cut at the boundaries of each occupancy section.
Diagram 70: Block with an occupancy and two momentary sensors

Diagram 70 shows a block driven by one occupancy (B) and two momentary sensors (A and C). Each of these sensors is associated with a contact indicator in the software called A, B and C. All indicators are assigned to the same block in the software. The block is indicated as occupied as soon as a train enters section B from any direction. The block remains occupied until the train leaves section B. The indicator A is additionally used as stop indicator for trains running to the left, C acts as stop indicator for trains running to the right. Both indicators additionally act as brake indicators for the opposite direction, respectively. The location of A and C should ensure, that each train is safely stopped before touching one of the switches. On the other side the longest train should completely fit into the block when being stopped. For this reason A or C, respectively, where trains are stopped, must be located close enough to the boundaries of the complete block.

The configuration displayed in Diagram 70 is usually less expensive then that displayed in Diagram 69, because momentary contacts are usually less expensive then occupancy sensors.

Diagram 71: Simple Block with two momentary sensors

Diagram 71 shows a simple configuration of block driven by two momentary sensors. Both sensors are associated with a contact indicator in the software called A and C. Both indicators are assigned to the same block in the software. The indicator A is additionally used as stop indicator for trains running to the left, C acts as stop indicator for
trains running to the right. Both indicators additionally act as brake indicators for the opposite direction, respectively. The location of A and C should ensure, that each train is safely stopped before touching one of the switches. On the other side the longest train should completely fit into the block when being stopped. For this reason A or C, respectively, where trains are stopped, must be located close enough to the boundaries of the complete block.

The configuration displayed in Diagram 71 is very simple and inexpensive but has also some disadvantages. Block occupancy is not indicated. As long as the block is reserved for a train located inside this block this causes no major problem, because the Dispatcher will not allow another train to enter this block. But certain measures are to be taken to avoid premature reservation of this block for another train when a train leaves the block. There is also a disadvantage for passing trains. Let us assume that a train is passing the block from the left to the right and that a route is to be activated before the block ahead, to the right of this block. As soon as the passing train enters the block at A the route is activated. In the same moment the train begins to slow down, because A is also a brake indicator and the train has to wait, until the route is reported to be activated which needs a certain time. This can be avoided by adding an additional contact according to the following diagram:

In Diagram 72 the indicator A is used as stop indicator for trains running to the left, C acts as stop indicator for trains running to the right. Indicator B acts as a brake indicator for trains running in both directions. In this configuration block occupancy is not indicated, too, and as in Diagram 71 certain measures are to be taken to avoid premature reservation of this block for another train when a train leaves this block. But trains can pass this block without any speed changes, even if there is a route to be activated before the block ahead – provided the distance between A and B or C and B, respectively, is large enough that the route can be activated after passing A or C, respectively, and before reaching B.
All examples discussed so far can be applied for blocks passed by trains in both directions. The configuration can be made simpler if trains pass a block only in one direction. This is shown in the following:

Diagram 73: Block with two occupancy sensors

Diagram 73 has been derived from Diagram 69 by eliminating sensor A. It is assumed that the block is only passed from the left to the right. B acts as brake indicator and C as stop indicator for trains running to the right.

The different configurations discussed in this section are only examples. Configurations similar to Diagram 73 can also be made with momentary contacts instead of occupancy sensors or with a mixture of both types similar to Diagram 70. One can think also of other configurations. There is no best way to setup a block. The optimal solution does not only depend on technical requirements but also which equipment you already got and how much you want to spend for new equipment.

In most of the examples discussed in the following sections blocks are represented only by one single indicator. This is done for reasons of simplicity. On an actual layout a block will almost always contain more than one indicator in one of the configurations discussed above.

One Sensor per Block: Combined Brake/Stop Indicators

For your convenience it is possible to replace certain contacts by combined brake/stop indicators. Assume the following configuration:
If your trains are running very precisely, then it is not necessary to mark the stop points A and C with separate indicators. Instead it is possible to specify the occupancy sensor B as combined brake/stop indicator for both directions. A combined brake/stop indicator accumulates the effect of a brake indicator and a stop indicator, that is located in a certain distance behind this brake indicator.

Assume that in the above example the desired stop point C is located in a distance of 50 inches to contact B. If it is desired, that trains decelerate and stop within 50 inches after entrance into B, then contact B can be specified as a combined brake/stop indicator with braking ramp 50 inches. If a train, that has to stop in this block, enters the occupancy section B from the left, it will be decelerated to threshold speed within 50 inches from the left border of B. When it arrives at the point C, which is 50 inches away from the entrance to B, the train will be automatically stopped.

In other words: the combined brake/stop indicator B with ramp 50 inches works exactly like a combination of a brake indicator with a braking ramp of 50 inches plus a stop contact located 50 inches behind this brake indicator.

Combined brake/stop indicators allow operation of a complete block with one single indicator symbol.

### 6.9 Block Signals

#### General

Traffic Blocking is used on real railroads to prevent two trains from running into each other by dividing the track into sections protected by signals. These signals (here called block signals) indicate to an oncoming train whether it can enter the block which begins beyond the signal. If the block ahead is occupied the driver of a train approaching the
signal protecting that block sees a red stop light. If the section in front is unoccupied and the train has permission to enter it the driver sees a green signal light.

When a train is running under control of the Dispatcher, Rocomotion automatically calculates signal aspects taking into account the availability of blocks and routes in front of the train. These signal aspects are displayed in the traffic boxes, that belong to the blocks. The signals indicate, whether the corresponding block may be left and how the following block must be entered. The brake and stop indicators assigned to a block take care that a train is stopped accordingly in front of the signal assigned to the same block. Since Rocomotion assumes that the brake and stop indicators belonging to a block are located near the exit of the block, this is also assumed for the location of block signals.

Rocomotion already displays the signal aspect currently valid for a certain block, when the first indicator assigned to this block is reached. It is possible to say: “The engineer is able to see the block signal at the end of a block already when the train enters the block.“

**Signal Aspects**

Rocomotion uses the following signal aspects - each is associated with a specific colour:

<table>
<thead>
<tr>
<th>Colour</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Stop</td>
</tr>
<tr>
<td>Green</td>
<td>Proceed</td>
</tr>
<tr>
<td>Yellow</td>
<td>Proceed Restricted</td>
</tr>
<tr>
<td>Grey</td>
<td>Signal not available</td>
</tr>
</tbody>
</table>

*Table 1: Signal Aspects*

For each train under its control the Dispatcher calculates the aspect of the next block signal. If the train must not enter the block, then the concerning signal is set to “red”. If the train may enter the block, then the signal is set to “green”. If the block is available and reserved for traveling with restricted speed, then the signal is set to “yellow”.

“Grey” is used, if the other colors do not apply. This is also the case, if the train is not running under control of the Dispatcher.
The calculated state of the main signal of each block is displayed on the according side in the symbol of the block.

![Diagram 75: Block Signals](image)

In the example displayed above a train may leave “Souhtown 1” and proceed to “Main Line East”. The signal symbol on the right side of the block shows green. The signal on the other side displays red, because it is assumed that the train must not enter “Main Line West”.

**How to use Signals on the Model Railroad Layout**

*Rocomotion* does not need any signals on your model railroad to control trains. But for realistic operation it should be possible to indicate the calculated signal aspects with appropriate signal models on your model railroad. For this purpose *Rocomotion* provides the feature to operate signal models on your layout according to the calculated aspects.

These signals are only used for indication. They do not need any facilities to control trains, because the trains are controlled by the Dispatcher.

It does also not matter, if the used signal models represent main or advance signals, because the models are only used for display. Selecting the appropriate signal model and location you are free to decide, where main and where advance signals will be visible. These signal models are of course operated depending to the *direction of travel*. For this reason you are able to perform the assignment of signals to blocks depending to the direction of travel.
Additional Notes

The internal signaling system of Rocomotion does not claim to simulate realistic signaling systems of the prototype. For each block the software only calculates, whether a train may leave this block to the related direction and whether any speed restrictions apply. This calculation is only done for those blocks, that are currently in the focus of an active schedule.

By assigning signal models to blocks the internally calculated aspects can be made visible on the layout if desired.

If a signaling system according to the rules of the prototype is desired, then this can be realized by using the calculated block signals and reservation and occupancy states of related blocks as well as logical associations based on conditions and operations as outlined in chapter 3, “The Switchboard”.

Diagram 76: Assigning Block Signals
6.10 Schedules

Schedule Diagrams

After completing the block system you will specify the desired train movements. This is done with the help of schedules.

Schedules describe how trains travel from certain starting blocks to certain destination blocks.

The base of each schedule is a schedule diagram. This diagram contains all blocks, routes and links of the main block diagram, that the train shall use on its journey. This diagram can be displayed on the computer screen, too. This is done by displaying those parts of the main block diagram, that do not belong to the schedule, transparently in the background of the computer screen as shown below:

Diagram 77 shows the diagram of a schedule, that starts in “Hidden Yard 3”, passes “Mainline East” and ends in “Souhtown 1”. The blocks, routes and links, that belong to
this schedule, are drawn with normal intensity, while the objects, that do not belong to
the schedule are drawn transparently in the background.

Additionally one or more starting blocks and optionally one or more destination blocks
are to be specified. Starting blocks are marked in the schedule diagram with a small
green marking, destination blocks with an orange or red marking. In the diagram above
“Hidden Yard 3” is marked as a starting block and “Southtown 1” is marked as a des-
tination block.

In order to start this schedule, assign an arbitrary train to block “Hidden Yard 3”, select
the schedule on the computer screen and call the appropriate start command of Roco-
motion. The Visual Dispatcher will automatically allocate the blocks and activate the
routes, that belong to this schedule and will automatically start the train. When the train
reaches the stop indicator in “Southtown 1” then the schedule is terminated.

A schedule can only contain elements, that are also contained in the main block dia-
gram. The location of each element in the display is determined by the location of the
referenced element in the main block diagram. If an element in the main block diagram
is changed, moved or deleted then this change is reflected in all schedule diagrams. In
this way multiple schedules can be conveniently maintained by changes of the main
block diagram.

**Start and Destination of a Schedule**

Each schedule contains one or more starting blocks and one or more destination blocks.
Starting blocks are marked in the schedule diagram with a small green marking, desti-
nation blocks with an orange or red marking.

**It is required that you mark the desired starting blocks otherwise the schedule
 cannot be started.**

After marking one or more blocks as starting blocks, the software automatically calcu-
lates one or more destination blocks. This is done according to the following rules:

- Each block which has no subsequent block in this schedule (“dead end”) is calcu-
lated as destination block. In Diagram 78, for example, “Northville2” is calculated
as destination block to the left. If a train executes this schedule, it cannot leave
“Northville2” to the left, because there is no other block to the left of “Northville2”,
that is contained in this schedule.
• Each block which closes a loop is calculated as destination block. On circular layouts usually each starting block is calculated as destination block to the same direction.

• If a block cannot be reached from the starting block, i.e. if there is no incessant chain of blocks, routes and connecting links between the starting block and this block, then this block is excluded from the schedule. Especially it is no destination block.

You can specify additional destination blocks yourself. But you cannot specify calculated destination blocks to not to be such destination blocks. Calculated destination blocks are marked with a small red marking. Destination blocks, that you specified yourself, are always marked with a small orange marking. In Diagram 78, for example, “Northville2” is calculated as destination block to the left. “Northville 1” is explicitly specified as a destination block and therefore marked with a small orange marking.

During operation it is only important, whether a block is a destination block or not. It does not matter, whether it is a calculated destination block (red marking) or a user defined destination block (orange marking). The red marking is only used to indicate the calculated destination blocks, that you did not mark as destination blocks yourself.
Start, destination and other schedule specific section settings are entered in the dialog box displayed below.

![Diagram 79: Schedule Specific Block Settings](image)

**Alternative Paths**

One of the most outstanding features of the *Visual Dispatcher* is the ease to specify alternatives for the path a train has to take when executing a certain schedule.
Diagram 80: Schedule Diagram with alternative Paths

Diagram 80 shows a schedule for train movements, that begins in of the three blocks in “Hidden Yard”, proceed on the mainline to clockwise direction, pass “Souhtown” through one of the two blocks and end again in “Hidden Yard”.

To start the schedule, assign a train to one of the blocks in “Hidden Yard”, select the schedule on the computer screen and call the appropriate start command of Rocomo-tion. The Dispatcher will automatically allocate the blocks and activate the routes that belong to this schedule and will automatically start the train. If there is more than one train located in “Hidden Yard” and both can be used with this schedule, then one of these trains is automatically selected. It is also possible, though, to pre-select the train yourself prior to starting the schedule.

The Dispatcher will also look for an appropriate path through “Souhtown” and will select a block in “Souhtown” as well as appropriate routes to this block, that are available. If both blocks of “Souhtown” are currently available, then the Dispatcher will perform a random selection. In the same way an appropriate block in “Hidden Yard” is selected, when the train approaches the destination.

Even more: each schedule can be started in either possible direction. If the schedule is started in the opposite direction, then the specified destination blocks of the schedule
are used as starting blocks and the starting blocks become destination blocks. The schedule of Diagram 80 can be therefore started in counter-clockwise direction, too.

Since the start and destination blocks are identical in this example the trains will start and end in “Hidden Yard”. In Diagram 77, though, a train will start in “Hidden Yard 3” and end in “Southtown 1”, if the schedule is started in the regular direction. Starting the same schedule in opposite direction will cause these two blocks to swap their meaning. “Southtown 1” will become the starting block and the train will end in “Hidden Yard 3”.

The terms start and destination are mainly used to describe, from where to where the trains travel on this schedule and where trains end. The actual starting block of a train can also be located in the inside of the schedule. In Diagram 80 the Dispatcher will try to find an available train in “Hidden Yard” first. But if there is no appropriate train in “Hidden Yard” then the Dispatcher can be instructed to start a waiting train in “Southtown”, if desired. If you select a waiting train in “Southtown” and start a schedule with that train, then the Dispatcher will use this train, even though it is not located in the starting block of the schedule.

The destination blocks are always used as the end point of each schedule. In other words: a train can be started in any block of the schedule and it will always make its way to an appropriate destination block, that can be reached from where it is started.

Looking at Diagram 80 we realize also, that with one single schedule diagram and by picking a few blocks, routes and links from the main block diagram, we can describe all possible train movements in both directions on the main line of this layout.

- The starting blocks of each schedule are to be specified manually.
- Based on the specified starting blocks the Dispatcher automatically calculates the destination blocks.
- A block without a link or route to a ‘next’ block with regard to the direction of travel of this schedule will automatically become a destination block (“Southown 1” in Diagram 77 is an example).
- In order to avoid endless loops on circular schedules each starting block will automatically become a destination block (the blocks in “Hidden Yard” of Diagram 80 are examples).
- It is possible to specify additional destination blocks manually. It would be for example possible to explicitly specify “Southtown 1” as an additional destination block in Diagram 80, too. If Southtown 1 is available, then each train coming from “Main Line East” will select “Southtown 1” as destination. If “Southtown 1” is not
available, then the train will automatically proceed via “Southtown 2” to “Hidden Yard”.
• It is not possible to reverse a train within a schedule. If, for example, a train enters “Southtown 1” from “Main Line West” then it is not possible to leave “Southtown 1 to “Main Line West” without terminating the current schedule and starting another schedule first. This other schedule can be another run of the same schedule diagram, though.
• It is not possible to change a train within a schedule.

Schedules describe train movements of one train from blocks to other blocks without changes of trains and without changes of direction.

You can create as many schedules as desired.

Schedules are not bound to specific trains, though. In principle each schedule can be executed with each train. In this way by specifying only a few schedules it is possible to achieve varied operation for many different trains. To start a schedule with a certain train, the train must be currently located in a block of this schedule, though.

6.11 Execution of Schedules

For varied operation or special situations you can specify among others the following attributes for each schedule:

• If the schedule shall be executed manually or automatically controlled by the computer.
• A time period, in which the Dispatcher repeatedly tries to start the schedule, if the first attempt to start the schedule fails.
• Whether certain blocks or routes of the schedule shall be passed with restricted speed.
• Whether and how often the schedule shall be repeated as a cycle or by a shuttle train.
• A selection of other schedules, which are started after finishing the schedule with regard to availability or by random selection.

Starting a Schedule

Each schedule can be started during operation of the layout in either of the two possible directions, i.e. from the starting to the destination blocks or vice versa.
When a schedule is being started, then the Dispatcher searches the starting (destination) blocks of the schedule until it finds a current block of a train, which is not already running on another schedule.

If no train is found on a block of the schedule or all trains are already running other schedules then the start of the schedule fails. It is possible to specify a time period, in which the Dispatcher repeatedly tries to start the schedule, if the first attempt to start the schedule fails.

A schedule is always started with one train. If the same schedule shall be started with several trains, then the start of the schedule must be executed several times according to the number of trains to be started.

**Reservation of Blocks and Routes**

When a train is started on a schedule, then the Dispatcher tries to reserve at least the current block and the next block in front of the train. Also, when a train enters a block, then the block ahead is reserved.
In the situation displayed above the train has just entered block “Main Line East” (displayed in red). The block ahead is reserved for the train.

If there is a route located between the block and the block ahead, then this route is activated, too. A route is assumed to be located between two blocks, if it connects these blocks in the schedule diagram.

If it is not possible to reserve at least one block ahead of the train or if the route to this block cannot be activated, then the signal at the related block exit is set to red and the train must not proceed.

When a certain block directly ahead of the train is about to be reserved, then the Dispatcher checks, whether there is a route behind the block ahead. If this is the case, then this route and the block behind of this route are reserved, too. This is done to reserve and activate the route in time before it comes to unintentional train stops caused by long lasting route activation.

In the diagram displayed above this method is shown. On entry into block “Main Line East” the Dispatcher does not only reserve block “Southtown 2” at the bottom. The Dispatcher also checks, whether there is a route directly behind “Southtown 2”. Since this is the case, this route and the block behind of this route are reserved, too. This is done to avoid unintentional train stops in “Southtown 2” due to the fact, that the train must not leave “Southtown 2” before the route to “Main Line West” is activated.

If “Southtown 2” and “Main Line West” were connected by a link that does not contain a route, then only “Southtown 2” would be reserved in this moment.

What happens, if “Main Line West” is currently not available in this situation? This is no problem. The Dispatcher only tries to reserve the additional route and the block behind of “Southtown 2”. If this is currently not possible, then the train is allowed to proceed at least to “Southtown 2”, though.

Path Selection

The Dispatcher follows a smart strategy, when it has to select one of several possible paths. In Diagram 80, for example, the Dispatcher has to select one of three possible paths, when a train is approaching the “Hidden Yard” from the west or from the east.

In the following the criteria which influence the selection of a path are listed. The following aspects lower the chance of a certain path to be used or might prevent a certain path from being selected at all:
• Other trains, that reserve one or more blocks and routes ahead of the train.
• Locks applied to the entry or exit of certain blocks (see page 77).
• Blocks or routes, that are reported as occupied by unknown objects.
• The distance to an appropriate destination block.
• Superfluous loops.

There are also criteria, that raise the chance of a certain path to be selected:

• Blocks ahead of the train that have been already reserved for this train.
• The distance to the nearest obstacle listed in the previous list.

At first the *Dispatcher* evaluates each possible path according to the criteria listed above. Two paths are equivalent with regard to these criteria, if exactly the same aspects apply. If two paths are equivalent, then the Dispatcher performs a random selection.

The criteria listed above do not prevent a path from being selected. They lower the chance of a path to be selected, though, but the Dispatcher might select a path, which is affected by a negative criterion, if there is no “better” alternative.

Special attention should be paid to the distance to an appropriate destination block. If the distances to appropriate destination blocks of two alternative paths are different, then the Dispatcher will probably select the shorter path. If the shorter path is currently locked by an obstacle, then it depends on the difference of these distances, whether the Dispatcher uses the longer path or decides to try to pass through the shorter path in the hope, that the obstacle disappears soon. In other words: the Dispatcher does not select a free path under all circumstances, especially not, if the free path is much longer than other alternatives, that are currently not available.

**Release of Blocks and Routes**

In general a block or route reserved by a schedule is released when the train has reached a block ahead of this block/route and when this block/route is not indicated as occupied anymore. In Diagram 80, for example, block “Main Line East” is not released before a train coming from “Hidden Yard” has reached “Southtown”. If “Main Line East” is still indicated as occupied when the train reaches “Southtown”, though, then release of “Main Line East” is further delayed until the occupancy indication of “Main Line East” is turned off.

In detail the following rules apply:
• A block is assumed to be reached, when the train reaches a stop indicator assigned to this block.
• An occupied block is not released. (An exception of this rule is outlined below.)
• A block or route is not released until the train has reached a block behind of this block/route.
• When a train reaches a certain block all not occupied blocks/routes located before this block, but not located behind another occupied and reserved block/route, are released. If, for example, “Main Line East” in Diagram 80 is still reserved and occupied when the train reaches “Main Line West”, then the used block of “Southtown” is not released, regardless whether it is occupied or not. If both, “Main Line East” and the related block in “Southtown”, are not occupied when the train reaches “Main Line West”, then both blocks are released.
• When the train reaches the destination position of the current schedule, i.e. the stop indicator in a destination block of this schedule, then all blocks and routes apart from this last block are released, regardless whether they are occupied in this moment or not.

Simulation of Train Movements without Connection to a Model Railroad

If no digital system is connected, then it is possible to simulate the stimulation of track sensors by clicking to the related contact indicators on the computer screen with the mouse. In this way you can perform a trial run of a train on a schedule before the model railroad is connected.

A very convenient way to simulate train movements is the use of the Traffic Control. The indicators currently visible in the Traffic Control can be turned on and off by clicking to them with the mouse, too, if the layout is not connected (see also chapter 7, “The Traffic Control”).

Restricted Speed and Wait Time

For each block in a schedule you can specify, if the affected section is passed with restricted speed or not.

Additionally you can specify a wait time for each block contained in a schedule.

Speed restrictions and wait time are specified in the dialog displayed in Diagram 79.

These attributes are specified on a per-schedule base. It is possible to specify different settings for different schedules.
Type of a Schedule - Shuttle and Cycle Trains

There are different types of schedules.

Normally – when no special type is selected – the journey of the train ends in a destination block of the schedule.

If a train shall repeat the schedule as shuttle train, it will be started again after arriving in a destination block and will run back in the opposite direction to an appropriate start block. It is possible to specify a repeat count to control, how often the schedule shall be repeated.

It is also possible to repeat the schedule as a cycle based on a circular diagram. In this case the train is started again on the same schedule after arriving at the destination block of the schedule. The train repeats traveling on the schedule in the same direction as before. Like for shuttle trains it is possible, to specify how the cyclic schedule shall be repeated.

When repeating schedules as a cycle it is necessary that these schedules are circular, i.e. destination blocks must be start blocks, too.

Running Trains manually under Control of a Schedule

For each schedule you can specify its mode. If desired you can control engine and trains on the schedule completely manually. In this case the Dispatcher reserves the blocks, activates the routes and calculates the block signals. You are – like a real engineer – responsible for obeying the indicated signals and following the speed conditions. But it is also possible to transfer the control over the schedule completely to the Dispatcher. In this case all engines and trains on this schedule are operated automatically. Finally it is also possible to share the engineer's job with the Dispatcher. In this way it is for example possible, that the train is running under your manual control, but that the Dispatcher is able to intervene to stop a train in front of a red signal.
<table>
<thead>
<tr>
<th>Mode</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>✨✨</td>
<td>Trains are completely controlled by the Dispatcher</td>
</tr>
<tr>
<td>🟢🟡</td>
<td>Dispatcher intervenes when restricted speed is prescribed or in order to stop a train</td>
</tr>
<tr>
<td>🔴</td>
<td>Dispatcher intervenes in order to stop a train</td>
</tr>
<tr>
<td>🟢</td>
<td>Trains are completely controlled manually</td>
</tr>
<tr>
<td>⬜</td>
<td>Schedule is used for shunting</td>
</tr>
</tbody>
</table>

**Table 2: Mode of a Schedule**

It is possible to use different modes for different schedules, regardless whether these schedules share the same blocks and routes or not. This enables full automatic operation of one part of your layout, running trains in a second part manually under control of the Dispatcher, operation of a third part as shunting area under control of the Dispatcher, and finally a fourth part outside the control of the Dispatcher.

Different schedules with different modes can be arranged for the same part of your layout. It is for example possible to create two schedules for the main track of your layout. The first schedule is used for automatically running trains, while the second schedule uses the same track for trains operated manually under control of the Dispatcher. In this way you can operate your favorite train manually while other trains in front of or behind this train are controlled automatically.

### 6.12 AutoTrain – Start of Schedules made Easy

*AutoTrain™* is another outstanding feature of *Rocomotion*. With *AutoTrain™* you can run automatic trains at any time during operation without the need to define schedules before.

*AutoTrain™* is especially useful in the following cases:

- If a train shall automatically run somewhere during operation and you did not specify an appropriate schedule before to perform this task.
- If you want to define a new schedule quickly from scratch.

The fastest way to run *AutoTrain™* is Drag & Drop with the mouse:

- Press and hold the key ‘A’ on your computer keyboard (A = *AutoTrain™*).
- Press the left mouse button near the exit of the block in the block diagram or in the switchboard, where the train shall start.
• Hold the left mouse button pressed and drag the mouse to the exit of the block in the 
  block diagram or in the switchboard, where the train shall stop.
• Release the left mouse button and the ‘A’ key.
• The train will now start and run automatically to the destination block.

With the *AutoTrain™* toolbar you have more options for individual customization be-
fore the train is actually started. To run a train with the *AutoTrain™* toolbar the follow-
ing steps are performed:

• Open the *AutoTrain™* toolbar.
• Select the locations (blocks) on the layout, where the train shall start.
• Select the locations (blocks) on the layout, where the train shall stop.
• Optionally specify additional options that influence the execution of the *Auto-
  Train™*, such as wait time, operations, cycle, shuttle, etc).
• Start *AutoTrain™*.

![Diagram 82: AutoTrain Tool Bar](image)

After start *AutoTrain™* automatically tries to find a path from the specified start block 
to the specified destination blocks. If a train is located in the start block, then it is auto-
matically started to run to the selected direction.

A started *AutoTrain™* is very similar to a schedule which is currently executed. It has 
one starting block and one ore more destination blocks, that are selected before *Auto-
Train™* is started.

There are some additional options:

• After selection of the start and destination blocks you can let *AutoTrain™* try to find 
a path from the start to the destination blocks without starting a train. This is useful 
in *edit mode*, especially if no train is located in the start block. This is also useful if 
you want to check the resulting path before actually starting the train. Together with 
another option, that allows to store the current *AutoTrain™* as a permanent schedule 
for later use, this is a very fast method to create new schedules by letting the soft-
ware calculate the appropriate paths for you.
• It is possible to select certain blocks to be included in the schedule anyway prior to 
start the search for an appropriate path. Each found path will then pass these blocks, 
if possible. This gives you more control over the resulting path.
• It is also possible to exclude certain blocks from AutoTrain™ prior to start the search for an appropriate path. This gives you additional control over the resulting path.
• You can also specify, whether only the shortest possible paths from the start to the destination blocks shall be taken into account or all possible paths.
• Additionally it is possible to limit the search to a maximum number of blocks. This option is useful in case of large or complex layouts and slow computers, where the search may take a certain while. Limiting the maximum number of blocks prior to starting the search can dramatically reduce the time needed to find the path.
• While an AutoTrain™ is active you can also store it as a schedule to execute it later, e.g. as part of a time table.

AutoTrain™ requires the prior creation of a full-functioning main block diagram.

AutoTrain™ follows the same rules with regard to the inclusion of blocks or routes as regular schedules. That means: like it is possible to include blocks or routes, that are currently locked, reserved, or occupied etc. into a schedule during edit mode, it is also possible that AutoTrain™ includes blocks or routes, that are currently locked or reserved by another train. In this way it is possible to let AutoTrain™ create a schedule for later use, that contains blocks or routes, that are currently not available. The only way to prevent certain blocks or routes from being included by AutoTrain™ is to explicitly exclude them prior to start the search. Even though it is possible to include blocks or routes, that are currently not available, into AutoTrain™ before the train is started, the train will not enter such blocks or routes after it has been started, just like in a regular schedule, too.

6.13 Successors of a Schedule

For each schedule it is possible to specify a set of other schedules, of which one is started, after the schedule is finished.

As explained in the following examples successors are used in many applications.
Several options allow you to specify how control of the train is passed from a schedule to its successor.

The successor is selected randomly. Additionally you can select to keep the train, i.e. to enforce that the successor continues with the same train as before, to enforce a train change or to continue with the oldest train, this is the train, which was not operated by another schedule for the longest time. If none of these options is selected then any available train is used. This can be the same train as before or another train.

In conjunction with the possibility to select successors randomly it is possible to control a hidden yard automatically. A train arriving in a hidden yard can be enabled to select another waiting train, which will leave the hidden yard.

If it is intended to start the successor with the same train, then it is recommended, that the successor starts with a destination block of the previous schedule. In this block the control of the train is transferred to the successor.

If several schedules shall be executed in a sequence, e.g. schedule 2 shall be executed after schedule 1 and schedule 3 shall be executed after schedule 2, then schedule 2 is to be specified as successor of schedule 1 and schedule 3 as successor of schedule 2.
Since it is not possible to reverse a train or to change trains during the execution of a schedule successors must be used if

- a train shall be reversed
- trains shall be changed

### 6.14 Schedule Selections

Sometimes it is desirable to select one of several schedules. This is supported by *schedule selections*. A *schedule selection* enables the selection of certain schedules out of a selection of several other schedules. Even though there is schedule diagram associated with a schedule selection such selection can be started like any other normal schedule. It can be used wherever a normal schedule can be used. When a schedule selection is started then one or more of the schedules contained in the selection are selected and started. This selection may also include other schedule selections.
7 The Traffic Control

During operation of a layout the Traffic Control shows the status of the currently selected train, block or route and the current status of the indicators, that have been assigned to the current object.

![Diagram 84: Traffic Control](image)

Here all important information about the currently selected train and its current location congregates. When you select a train on the computer screen, then this train and the block, where it is located, are displayed here. When you select a block or a route, then this block/route and the train, which is currently there, if any, are displayed.

The speed of the train is made visible with a colored rectangle. The status of the block, whether occupied or not, and the status of the block signals on both exits are displayed as well.

Additionally the indicators, that have been assigned to the block or to the route, are displayed. The status of each indicator, whether occupied or not, and the usage of each indicator as a brake or stop indicator for a certain direction are displayed here, too.

If the digital system is running in offline mode, then you can toggle the state of each indicator by clicking to it with the mouse. In this way the movements of trains can be simulated very conveniently: simply select the block that you want to look at on the computer screen and click to the occupancy, brake or stop indicator to simulate what happens if a train passes this indicator. Please refer also to page 102 for further details about simulation.
8 A Sample Layout

General

The layout displayed below shall be operated with **Rocomotion**:

![Diagram 85: Sample Layout](image)

The layout has two stations: “Southtown” located on the left side of the layout and “Northville” located at the end of the branch line. There is an additional hidden yard that is covered by the mountain.

This can be seen better in the track plan displayed below:
The main line, i.e. the loop that connects “Hidden Yard” and “Southtown”, will be operated automatically under full control of the Dispatcher. The branch line from “Southtown” to “Northville” will be operated manually.

In the following the necessary steps to control this layout are explained.

**Step 1: Creating the Switchboard**

The first steps are creation and drawing of the switchboard.
Diagram 87 shows the switchboard of the sample layout. All switches get appropriate names. The related digital addresses are assigned, too.

At this stage we are able to control all switches on our sample layout.

**Step 2: Defining the Engines**

Our switchboard is now completed and we are going to create the entries for the engines that we want to run on the layout. We want to run three trains, a passenger and a freight train that can run on the main line only, and an additional train that can go to Northville, too. The trains are entered into the Train Window as displayed below:
By editing the properties of each engine we assign a digital address to each engine and can additionally specify engine functions, measure the threshold speed and the speed profile and edit other properties. This is not outlined in detail here, because it is not important for understanding of this sample layout. Further details can be found in chapter 4, “Train Control”.

The images have been prepared with TrainAnimator™.

Through the Window menu of the software you can open additional Train Windows, if you like to control each train through a separate Train Window.

At this stage of the sample we are able to control our trains manually with the computer on all parts of the sample layout.
Step 3: Creating Blocks

At first we divide our layout into logical blocks. We follow the guidelines on page 67. The resulting block structure looks as follows:

Diagram 89: Block structure of the sample layout

Each blue track section represents a separate block.

Based on this diagram we insert a traffic box for each block into the switchboard. The resulting switchboard is displayed in the next diagram:
Based on this switchboard the *Visual Dispatcher* automatically calculates the following main block diagram:
Please note that the block diagram represents the track layout in rough outline. The actual track connection between “Main Line West” and “Hidden Yard 3”, for example, contains two switches. These switches are not drawn in the block diagram in detail. Instead a route between both blocks is created.

All necessary routes between all blocks are created and recorded automatically.

**Step 4: Contact Indicators**

We want to equip each block on the main loop with three occupancy sensors. The arrangement of indicators of each block follows Diagram 69 (please refer to page 84). The occupancy sensor in the center of each block (dark red zones in Diagram 92) will be used as brake indicator for both directions; the sensors on both sides of each block will be used as stop indicator for the related direction (light red zones in Diagram 92).

The branch line to “Northville” contains 3 blocks. Since we do not want to run automatic trains there it is sufficient to install one occupancy sensor in each of these blocks for train tracking of manual trains.
Diagram 92: Indicator arrangement of the sample layout

The grey tracks in Diagram 92 are not contained in any block. They are part of routes, which are assumed here to be located between the blocks.
Indicators are created for each block according to the following table:

<table>
<thead>
<tr>
<th>Block</th>
<th>Indicator</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hidden Yard 1</td>
<td>Hidden Yard 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hidden Yard East 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hidden Yard West 1</td>
<td></td>
</tr>
<tr>
<td>Hidden Yard 2</td>
<td>Hidden Yard 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hidden Yard East 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hidden Yard West 2</td>
<td></td>
</tr>
<tr>
<td>Hidden Yard 3</td>
<td>Hidden Yard 3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hidden Yard East 3</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hidden Yard West 3</td>
<td></td>
</tr>
<tr>
<td>Main Line East</td>
<td>Main Line East</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hidden Yard East Entry</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Southtown East Entry</td>
<td></td>
</tr>
<tr>
<td>Main Line West</td>
<td>Main Line West</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Hidden Yard West Entry</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Southtown West Entry</td>
<td></td>
</tr>
<tr>
<td>Southtown 1</td>
<td>Southtown 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Southtown East 1</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Southtown West 1</td>
<td></td>
</tr>
<tr>
<td>Southtown 2</td>
<td>Southtown 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Southtown East 2</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Southtown West 2</td>
<td></td>
</tr>
<tr>
<td>Northville 1</td>
<td>Northville 1</td>
<td></td>
</tr>
<tr>
<td>Northville 2</td>
<td>Northville 2</td>
<td></td>
</tr>
<tr>
<td>Branch Line</td>
<td>Branch Line</td>
<td></td>
</tr>
</tbody>
</table>

Table 3: Indicator Configuration

The small icons indicate in which direction of travel a certain indicator is effective as brake or stop indicator. The indicator “Hidden Yard 1”, for instance, marked by □ and □ is used as brake indicator of block “Hidden Yard 1” for both directions of travel.
The indicator “Southtown East Entry”, marked by ▶ is used as stop indicator of block “Main Line East” for trains that pass this block from the top to the bottom of the layout, i.e. from the Hidden Yard to Southtown. For trains running to the opposite direction this indicator reports that the train enters the block.

**Step 5: Creating Schedules**

One single schedule is sufficient to describe all train movements on the main line of the sample layout:

The blocks in “Hidden Yard” are marked as start blocks of the schedule. Since the schedule forms a closed loop these blocks are automatically calculated as destination blocks, too. The schedule can be started to both directions, i.e. trains can run clockwise or counter-clockwise under control of this schedule. Depending on a specific setting of this schedule, it allows either for train movements that start in Hidden Yard or for train movements that start in any other block of the main loop. All train movements will end in “Hidden Yard”, though.
Manual Operation

The branch line from “Southtown” to “Northville” and back shall be operated manually.

All precautions for train tracking have been already done by integrating the blocks of the branch line into the main block diagram accordingly.

Trains waiting in “Southtown” and bound to “Northville” will release block “Southtown 2” as soon as they left “Southtown”. They will be automatically tracked to “Northville” and back. All is done by proper drawing of the main block diagram, no further measures are to be taken. A train that comes from “Northtown” and arrives in “Southtown” will automatically reserve block “Southtown 2” again.

From there it can be started by the schedule shown in the previous section and automatically travel to the “Hidden Yard”. This can be done even automatically on arrival in “Southtown” without further intervention by the human operator.
Appendix

Using digital Components of the ROCO System

Programming the Switch Decoder 10775 using Rocomotion

Programming via Route Control means setting the decoder to programming mode and executing a switch command. Exactly the same applies to Rocomotion software. Create a switch icon, set the desired address in the icon’s properties, and click the icon. The software sends the command to program the decoder, which must be in programming mode, just as would happen under Route Control programming.

Programming the Feedback Module Decoder 10787 using Rocomotion

In the appropriate block (or Traffic Box) select the Indicators tab. Click Properties and click Setup and follow the instructions on screen. Please note that, to program a feedback module, only one module must be connected at a time. During normal operation you can, of course, have multiple modules connected, the addresses of which must, however, be in ascending sequential (no address gaps) order. For verification the LEDs display the programmed address after the self-test.
Index

acceleration 59  
accessories 46  
accessory element 47  
address, digital  
  of accessories 47  
  of engines 54  
  of signals 47  
  of switches 43  
automatic Operation 65  
automatic route 48  
AutoTrain 106

bitmap  
  in the switchboard 50  
block 69  
  and indicators 81, 82  
  brake indicator 82  
  current block 77  
  locking a block 79  
  locking the exit of a block 79  
main block diagram 71  
occupied block 76  
release in a schedule 103  
reservation in a schedule 101  
reserved block 77  
  states 76  
  stop indicator 82  
block diagram  
  automatic calculation 71  
block signal 90  
  signal aspect 91  
brake indicator 82  
  combined brake/stop indicator 89
bridge 42  
bumper 42

combined brake/stop indicator 89
commands  
  properties of accessories 47  
  properties of engines 54  
  properties of routes 48  
  properties of signals 47  
  properties of switches 43  
contact  
  momentary 61  
  occupancy sensor 61  
  contact indicator 61  
  momentary contact 61  
  occupancy sensor 61  
crossing 42  
current block 77  
curve 42  
cyclic schedule 105  
deceleration 59  
destination block of a schedule 95  
digital address  
  of accessories 47  
  of engines 54  
  of signals 47  
  of switches 43  
direction of travel 75  
Dispatcher 65  
display of train positions 51  
distance, simulated 56  
double slip switch 42  
  solenoids 45
edit mode 37  
engine  
  digital address 54  
  orientation 75
feedback indicator 61
file
  layout file 36
  status file 36
four aspect signal 47

hidden yard 109

image 50
image element 50
indicator
  and blocks 81
  combined brake/stop indicator 89
  contact indicator 61
  feedback indicator 61

label
  in the control panel 50
layout file 36
light 47
link
  between blocks 74
locking block exit 79
locking of blocks 79

main block diagram 71
manual route 48
maximum scale speed 55
menus
  Edit 48
  Edit, Switchboard 43, 47
  Edit, train window 54
mode, of a schedule 105
momentary track contact 61
momentum 59

occupancy sensor 61
occupied block 76
odometer 56
on-off switch 47
optical sensor 61
orientation
  of an engine 75
path selection in schedules 102
position
  display of train positions 51
  push button 47
reed contact 61
release of blocks and routes in a
  schedule 103
reservation of blocks and routes in a
  schedule 101
reserved block 77
restricted speed 104
reversing loop 78
route 47
  automatic route 48
  between blocks 74
  manual route 48
  release in a schedule 103
  reservation in a schedule 101
scale speed 56
scale speed, maximum 55
schedule 94
  cycle 105
  mode 105
  path selection 102
  release of blocks and routes 103
  reservation of blocks and routes 101
  starting and destination block 95
  successor 108
schedule diagram 94
schedule selection 110
selection
  of a schedule 110
sensor
  momentary track contact 61
  occupancy sensor 61
shuttle train 105
signal 46
signal aspect
  block signal  91
simulated distance  56
single slip switch  42
slip switch  42
sound files
  engine function  58
speed profile  57
speed, scale  56
speedometer  56
starting block of a schedule  95
status file  36
stop indicator  82
  combined brake/stop indicator  89
straight  42
successor of a schedule  108
switch  42
switchboard recorder  48

text element  50
text label  50
three aspect signal  47

threshold speed  56
throttle  55
toggle switch  47
track contact  61
track elements  42
track occupancy sensor  61
traffic box  71, 79
Traffic Control  111
train detection  79
Train List  52
train position
  display  51
train tracking  79
Train Window  52
triple switch  42
turntable  42
two aspect signal  47
uncoupler  47
wait time  104